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Part 1 Introduction of CS series potentiostat / galvanostat

CS Potentiostat / Galvanostat (electrochemical
workstation) contains a fast digital function generator,
high-speed data acquisition circuitry, a potentiostat and a
galvanostat. With high performance in stability and
accuracy with advanced hardware and well-functioned
software, it is a comprehensive research platform for
corrosion, batteries, electrochemical analysis, sensor, life
science and environmental chemistry etc.

Applications
①Electrosynthesis, electrodeposition (electroplating), anodic oxidation, etc.
②Electrochemical analysis and sensor;
③Battery (Li-ion battery, solar battery, fuel cell, supercapacitor), new materials,

optoelectronic materials;
④Corrosion mechanism of metals in water, concrete and soil;
⑤Fast evaluation of corrosion inhibitor, water stabilizer, coating and cathodic protection

efficiency.
Specifications

Support 2-, 3- or 4-electrode system
Potential control range: ±10V
Current control range: ±2A
Potential control accuracy: 0.1%×full range±1mV
Current control accuracy: 0.1%×full range
Potential resolution: 10μV(>100Hz), 3μV (<10Hz)
Current sensitivity: 1pA
Potentiostat rise time: <1μs (<10mA), <10μs(<2A)
Reference electrode input impedance: 1012Ω||20pF
Current range: 2nA~2A, 10 ranges
Compliance voltage: ±21V
Maximum current output: 2.0A
CV and LSV scan rate: 0.001mV~10,000V/s
CA and CC pulse width: 0.0001~65,000s
Current increment during scan: 1mA@1A/ms
Potential increment during scan: 0.076mV@1V/ms
SWV frequency: 0.001~100 kHz
DPV and NPV pulse width: 0.0001~1000s
AD data acquisition: 16bit@1 MHz,20bit@1 kHz
DAResolution: 16bit, setup time: 1μs
Minimum potential increment in CV: 0.075mV
IMP frequency: 10μHz~1MHz
Low-pass filters: covering 8-decade
Potential and current range: automatic
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EIS specs
Signal generator:
Frequency range: 10μHz~1MHz
Frequency accuracy: 0.005%
AC signal amplitude: 1mV~2500mV
Signal resolution: 0.1 mV RMS
DC Bias: -10~+10V
Output impedance: 50Ω
Waveform: Sine wave, triangular wave and square wave
Wave distortion: <1%
Scan mode: Logarithmic/linear, increase/decrease
Signal analyzer:
Integral time: minimum: 10ms or the longest time of a cycle
Maximum: 106 cycles or 105s
Measurement delay: 0~105s
DC offset:
Potential automatic compensation range: -10V~+10V
Current compensation range: -1A~+1A
Bandwidth: 8-decade frequency range, automatic and manual setting
System Requirements
Operating System: Windows /7/ 8/10/11
Communication between PC and instrument: USB2.0.
Dimensions(cm):36 ×30×14; weight: 6.5kg

Front panel of CS single channel potentiostat/ galvanostat

LED screen: display the current range, load status, working mode, polarization status
Cell- This port is insert the cell cable to connect the instrument with the cell system. Each cell
cable has 5 leads/clamps.
3- electrode system Cable connection

Greed clamp (WE) connects to working electrode (WE)
Red clamp (CE) connects to counter electrode (CE)
Yellow clamp (RE) connects to reference electrode (RE)
Black (GND) connects to galvanic electrode WEⅡ in electrochemical noise experiment.
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If use a Faraday cage, black GND and Shield connect the cage together.

2- electrodes system Cable connection

The green lead connects to WE or anode;

red lead & yellow lead together connect to another electrode or cathode.

Rear panel of CS single channel potentiostat galvanostat

AC 220V or 110V: AC 220V or 110V power socket with fuse, 1A fuse in the bottom box.
External control interface: used to synchronously control the external stirrer, motor

rotating rate, etc., or as a frequency meter for frequency testing of external signals (can be
connected to a quartz crystal microbalance (QCM).

USB: using USB to connect the potentiostat with a computer.
LAN: using an Ethernet cable to connect the potentiostat with a computer.
Analog input and output: the analog input and output expansion port of the instrument.
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Schematic diagram

Schematic diagram of CS potentiostat

Standard supply list:
For one set of CS potentiostat/galvanostat,
Standard supply list:
Instrument host ×1

CS studio software ×1
Dummy cell×1
Power cable ×1
USB cable (single channel) or Ethernet cable(Bi or multichannel potentiostat) ×1
Cell/ Electrode cable ×2
Manual×1
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Part 2 CS Studio6 Software
1. Introduction
CS Studio software shipped with the CS electrochemical workstation is an easy-to-use,

flexible, and versatile electrochemical tool. It can be applied in many research fields such as
corrosion, voltammetry, electroanalysis or battery test, etc. Computer Operating system should
be Windows-based. There is no other requirement for computer. A mainstream/ common one
in the market is OK.

Interface of CS Studio software

1.1 Electrochemical Techniques

# There is the corresponding stripping method.
Stable polarization: Open Circuit Potential (OCP), Potentiostatic (I-T curve), Galvanostatic,
Potentiodynamic (Tafel), Galvanodynamic, Potential Sweep-step
Transient polarization: Multi-Potential Steps, Multi-Current Steps, Potential Stair-Step
(VSTEP), Galvanic Stair-Step (ISTEP)
Chrono Methods: Chronopotentiometry(CP), Chronoamperometry (CA), Chronocoulometry
(CC)
Voltammetry: Cyclic Voltammetry (CV), Linear Sweep Voltammetry (LSV), Staircase
Voltammetry (SCV)#, Differential Pulse Voltammetry (DPV)#, Normal Pulse Voltammetry
(NPV)#, Square wave voltammetry (SWV)#, ACvoltammetry (ACV)#, Differential Normal
Pulse Voltammetry (DNPV)#, 2nd Harmonic A. C. Voltammetry (SHACV), Fourier Transform
AC Voltammetry(FTACV)
Amprometric:Differential Pulse Amperometry (DPA), Double Differential Pulse
Amperometry(DDPA),Triple Pulse Amperometry (TPA), Integrated Pulse Amperometric
Detection (IPAD)
Impedance: EIS vs Frequency (IMP), EIS vs Time (IMPT), EIS vs Potential (IMPE)
Corrosion measurement:Cyclic polarization curve (CPP), Linear polarization curve (LPR),
Electrochemical Noise (EN), Zero Resistance Ammeter (ZRA), Electrochemical
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Potentiokinetic Reactivation(EPR)
Battery testing: Battery charge and discharge, Galvanostatic charge and discharge(GCD)
Bipotentiostat: Hydrogen diffusion (HDT), Rotating ring-disk Electrode(RRDE)
Extensions:Data Logger, Disc machine control, Bulk electrolysis with Coulometry

CS Studio software is also equipped with powerful corrosion analysis module.It can
calculate the corrosion rate of the material by linear polarization and weak polarization, as
well as polarization resistance (Rp), Tafel slope (ba, bc), and corrosion current density (icorr)
through the non-linear fitting of Tafel plots. In addition, by the built-in electrochemical
impedance spectroscopy (EIS)technique, it can measure the double layer capacitance (Cdl) and
the solution/ concrete resistance(Rs). Moreover,CS Studio software provides as a dual-channel
data logger for pH, temperature and some physical quantities records.

1.2 Software Installation

1.2.1 CS single channel models-USB(CS350/CS310/CS300/CS150/CS120)
1. Using the USB cable to connect the potentiostat with a computer.

2. Power on the instrument, open the “software installation” folder in USB flash disk., right
click the “CS studio6 setup”, and run as administrator.



Manual of Corrtest Potentiostat / Galvanostat

- 7 -

3. Firstly, install the drivers. After finishing it, go to the computer management → device
manager→ Ports (COM & LPT). There, it will appear “STM… virtual COM Port(COM x)”.
As is shown below.

4. Secondly, install the runtime environment. If your computer has already installed it, there
will be a prompt saying you have already installed.

If it hasn’t been installed in your computer, just follow the steps to finish installation of
runtime.

5. Click install CS Studio6. Created a shortcut is on the desktop.

6. Run the software as administrator. Then the model and serial number will be shown. It
means the instrument has been successfully connected.

1.2.2 Bipotentiostat and multichannel potentiostat(Ethernet cable)

The installation process is the same for bipotentiostat and multichannel potentiostat
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Software installation
(1) Use the Ethernet cable to connect the computer with the instrument. Power on the
instrument.

(2) Open the “software installation” folder, right click the “Setup.exe”, and run as
administrator.

(3) For potentiostat more than one channel, we use Ethernet communication. So there is
no need to install drivers. Firstly, install the .net 3.5. If your computer has already installed it,
there will be a prompt as follows.
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If it has not installed in your computer, just follow the steps to finish installation of .net
3.5.

(4) Click install CS Studio5. Created a shortcut is on the desktop.

IP address configuration (Windows 10 operation system as an example)
Connecting the instrument (Bipotentiostat or multichannel potentiostat) with computer by

Ethernet cable, you should reset the IP address of the computer.

(1) Find the “Network and sharing center”

Then, Ethernet →Network and sharing center

Computer
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(Or → Network and sharing center)

(2) Click “Ethernet” shown as below:

(3) Click “Properties”, then check “Internet Protocol version 4(TCP/IPv4)”
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(4) Fill in the IP address exactly as below:

(5) Open CS Studio5 software, “Setup” → Connection→“Ethernet” →Manual
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(6) When the bipotentiostat CS2350 is successfully connected with the computer, there
will be model and serial number shown on the software interface, as is shown below.

2. Menu
There are key shortcuts for experiment techniques, such as “F2” for “Open Circuit

Potential”, F4 for technique of “Potentiodynamic”.
There is a toolbar under the main menu, and it can achieve the same function as the main

menu, and there will be a text message tip when you put the mouse on.
the “Experiments” will appear when you right-click the mouse on anywhere of the

window. You can choose one technique to perform. Of course you can clicking main menu of
“Experiments” and then click one technique.

The button will be activated when a test is running. You can click it to stop the test.
This button will gray out when you finish a test.

2.1 File

2.1.1 Open File
Open a “.cor” data file. You can view data and do analysis.

2.1.2 New Project

Build a new project window. The original project window will not be closed or replaced.
2.1.3 Open Project

Open a project file. You can view the file and do data analysis.
2.1.4 Save Project

Save the project window file in project file format.
2.1.5 Save Project As

Save data file or project file as a new project file.
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2.1.6 Close Project
Close an open project window. If no file is open, this menu is disabled.

2.1.7 Page Setup
Set the format for printing output .

2.1.8 Print
Output the graph of the open file to the printer.

2.1.9 Exit
Exit the CS studio software. When a test is being performed, there will be a prompt.

2.2 Setup

Connection
It’s used to modify the communication way of the instrument.
For single channel potentiostat it’s USB
For bipotentiostat and multichannel potentiostat, it’s Ethernet.

Settings

Here you can change the default place for data storage.
Fragmentation is used for big amount data. For each fragment the data points can be set.

Default is 1,000,000.
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Restore default
This is to restore to the factory default state. The stored experimental data will not be

deleted.

3. Experiment Setting
3.1 Pstat/Gstat(ECS)Setting

Open a technique, and you can do the instrument setting by clicking .
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Potential Range
Potential range can be ±2.5V, ±5V, or ±10V. The default range is ±2.5V. The narrower the

range is, the higher the input signal gain. Normally when the potential signal input is in the
range of ±2.5V, “±2.5V” range is OK. But if the potential of the tested system is over ±2.5V,
you must choose the range to be ±5V, or ±10V.
Current Range
You can choose either “Manual” or “Auto”. If check Manual, the drop-down box is

activated, and you can choose a suitable current range. If the current in the experiment reaches
120% of the set range, then the software will automatically cut off the polarization of the
potentiostat. “Auto” allows the instrument to select the suitable current range according to the
polarization current.
“Min Range” - you can set a limitation for minimum current range to avoid possible extra
noise in some high-resistance systems in case the current range is too small.
“Only Inc” means the current range will be switched only from lower range to higher range,
just in this direction. This is particularly useful for CV experiment.
In the moment of current range switching, noise may be inevitable. Therefore, it is

recommended to choose a fixed current range in fast measurements or when the data
acquisition frequency is high.
OCPCheck
If you check the radio button “Use”, the software will judge whether the open circuit

potential is in the range that you set. If yes, the experiment will conduct automatically if you
have set the data file save path.
Quiet Time
Enter a number or drag the slider, you can specify the duration of delay for scan. The

maximum delay time is 1000s. Setting the quiet time can make the measuring current stable,
especially when polarization doesn’t start from OCP. Transient polarization may cause a large
current, and the value will decrease as time goes by. Therefore, there should be a quiet time
before formally recording data.
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Before this window appear, the potentiostat is already in the state of polarization, but
doesn’t start scan. If you think the polarization current is already stable, then you can click
Run anytime to start testing. You can click cancel to quit the experiment.
When the countdown is completed, the scan will start automatically.
If you set “Auto” change current range, during this process, CS studio software will auto

choose the suitable range according to the actual current. If the current range is set to be
“manual”, once the current is overloaded, the software will give you a prompt to change a
larger current range. If you choose “No”, then the software will control the instrument to
change from polarization state to natural state.
IR Compensation
In high-resistance system, the solution resistance (Rs) is large between the working

electrode and the tip of Luggin capillary where the reference electrode is put, especially for
concrete or coated samples, so it must be compensated. Rs measurement can be done with
method of Potential Stair-Step (VSTEP). Enter the Rs value in the feedback for IR
compensation in the subsequent measurements.
Ground mode
There are two modes for the working electrode: virtual and real. The “virtual” mode is

suitable for most stable test systems. As for electrochemical noise or galvanic corrosion
measurement, you must choose “virtual” mode. Real mode is suitable for a system where the
working electrode is connected to earth, such as the rebar in the concrete. For EIS test, you
should choose real mode to increase the high-frequency response characteristic.
Low Pass Filter

The frequency response bandwidth of the power amplifier in the potentiostat can be
change by this setting. The higher the capacitance you choose is, the narrower the bandwidth
of the potentiostat is.
If all the filters are closed, then the power amplifier has the best frequency response

characteristics. But for some high-resistance systems, oscillation may appear. If you use the
virtual mode and choose a low capacitance, it is very likely for the instrument to occur
oscillation even positive feedback. You should decrease the bandwidth of the amplifier, i.e.,
increase the capacitance in the low pass filter.
When increasing the capacitance, the response frequency bandwidth will decrease, which

equals to low-pass filtering the signals. Normally, for slow scan experiment, you can choose
10nF~100nF; for fast scan or transient measurements, you can choose 100pF~10nF; For EIS
measurements, you may need to choose 100pF~10nF(virtual) or 0~1nF(real).
Data smooth
When choosing data smooth, the software will do real-time filtering of the data and

automatically get rid of the burrs on the curves. Please note that when you do transient
measurements, you don’t need to use it because it can bring slight distortion for data.
Notch filter
If you check the notch filter and choose the frequency, the interference can be restrained

when the experiment is being conducted.

3.2 Cell Setting

You can enter related information of one or more working electrode(s) and electrolytic
cell(s), eg. surface area, material, and temperature... The electrode area, density and chemical
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equivalent will affect the results of experiment and fitting. Temperature or type of RE will not
affect the original data; they are just saved in each data file for info. Meanwhile, these
parameters are needed for corrosion rate calculation.

Electrode
Electrode Area: the exposed area of the working electrode in the solution. It is the

effective working area. Unit is cm2. Default is 1. If it is 1, the current density will be the same
as the measured current in value.

Density: the density of the material of the working electrode. Unit is g/cm3.
Chemical Equiv = the molar mass/number of electrons transferred in a reaction. Take the
reaction Fe→ Fe2+ for example, the molar mass of pure Fe is 55.84g, and the number of
transferred electrons is 2, so the equivalent weight is 55.84g/2=27.92g.
Cell parameters
Reference electrode: in the drop box you can choose SCE, Ag/AgCl, Hg/HgO, Hg/HgSO4,
Cu/CuSO4... You can also choose “Custom” if your RE is not in the list, then you should
specify the value of “V vs. NHE” (normal hydrogen electrode).
V vs. NHE: it is the relative potential of the selected reference electrode vs. NHE.
Temperature: it is the temperature for the electrochemical reaction at present.
Stern- Geary Coef.: in the range of 20 ~28mV.
Active channel
For single-channel CS potentiostat, there is only 1 channel. For multi-channel potentiostat,

you can set the cell information independently.

4. Combination test

This is a very useful function.
You can add several experiments, for each test you can modify the parameters setting, and
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the number of cycles can also be set. After setting the experiments and control instructions,
click the "OK" button, and the instrument will automatically test and save the data according
to the custom requirements. This function can be achieved your unattended measurements.
You don’t need to wait in the lab and it will complete a series of experiments automatically. It
will make the tests efficient and save your time.

Build a project

Save the project

Start

Pause

Add an experiment

Modify

Remove
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Adjust the order of the instructions and experiments

5. Stable Polarization
5.1 Open Circuit Potential

Experiments → Stable Polarization→ Open Circuit Potential
This experiment aims at monitoring the open circuit potential (or free corrosion potential,

i.e., the potential difference between WE and RE without any applied electric field) as a
function of time. The experiment can be performed for a fixed duration or until a particular
potential is reached.

Before test, the OK button is invalid. Only when you enter a file name can this button be
activated. All the data will be saved in this file.

OCP (V) will display the current open circuit potential of the cell (update per second).

File Name
You’re suggested to build up a new folder for all the data files, then enter a file name

before starting the test. You can click “Browse”and find the place where data files to be saved.
If you don’t click browse and directly enter a name and confirm, then the default data

storage path is as follows:
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CS Studio will automatically append the suffix “.cor” to a file name. So if you input
“tutor1”, the name of the data file will be shown as “tutor1.cor”.

The info in the Comments box will be saved in the data file. You can input info. such as
the medium, the solution content, etc. Other info. such as the time when you perform the test,
and all the related measurement parameters will be automatically saved in the data file. You
don’t need to enter such information into comments.

Experiment parameters
Total Time: decides the total duration of the experiment.

Data Acquisition
Choose either “Interval” or “Frequency”.
Interval determines the time between each sampled data point. Frequency (Hz) specifies

the data points sampled per second (acquisition rate). Please note that the interval cannot be
set lower than 0.001s, i.e., the points/second cannot be higher than 1000. Otherwise, the
software will automatically set the frequency to be 1kHz (the maximum value allowed).
Experiment Termination

If the Use is checked, the experiment will be automatically terminated once the OCP goes
above the high value (2V in the above dialog box for instance) or below the low value (-2V).
Axis Type

You should set the Axis type for display of each dynamic graph. For OCP, the axis type is
“E-Time”.
Pstat/Gstat(ECS)

See 3.1 Pstat/Gstat(ECS) Setting
Cell Setup

See Cell Setting 3.2.
Click OK to exit the parameter setting dialog box, and enter the “wait…” interface before

testing. Meanwhile, CS Studio will save all the parameters that you set and remain the same
the next time when you run this experiment.

Click “Cancel” also to exit the dialog box, not conducting the experiment. All the set
parameters will be lost.

Click Help to access to the on-line help information on the setup of this experiment.
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5.2 Potentiostatic

Experiments→ Stable Polarization →Potentiostatic
In this experiment, the potentiostat applies a constant polarization potential on the

working electrode and monitor the polarization current as a function of time. The polarization
duration (Total Time) can be set by the user, or you can also let the experiment be
automatically terminated when the polarization current or quantity of electric charge reaches
to a certain value (change from the polarization state to OCP state).

OCP (V) will display the current open circuit potential of the cell (update per second).

Experiment Parameters
Applied Potential is the potential applied on the measured system. It can be potential “vs.

OCP” or “vs. RE”.
For CS series potentiostat, choosing potential “vs. OCP”, the input of a positive value

means anodic polarization, negative value means cathodic polarization. Under potential “vs.
OCP”, input of a positive value means anodic polarization, negative value means cathodic
polarization. The actual potential applied on the WE is the algebraic sum of the input value
and the current open circuit potential. For example, enter “0.2”, then the actual potential
applied on the working electrode is “0.2V+OCP”. If selecting “vs. RE”, then the polarization
potential applied on the working electrode is exactly 0.2V.

Total Time determines the total time of potentiostatic polarization. Unit is Second,
minute or hour.
Experiment Termination

If the Use I box is checked, the experiment of potentiostatic will be automatically
terminated once the polarization current goes above the high value (anodic current, 250mA in
above dialog box for instance) or below the low value (cathodic current, -250mA in above
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dialog box for instance).
If Use Q is checked, the experiment of potentiostatic will be automatically terminated

once the total integral quantity of electric charge (coulombs) goes over maximum value
(positive charge) or below minimum value (negative charge).

If the Disable is checked, the above two experiment termination prerequisites are
ineffective. The experiment will not be terminated until the total time is reached.
Axis Type

When the experiment is performed, the data will be displayed as specified by the Axis
Type. CorrView can be later used to display the data in other formats. For the experiment of
Potentiostatic, the axis type is “I-Time”.

5.3 Galvanostatic

Experiments →Stable Polarization →Galvanostatic
In this experiment, the instrument applies a constant polarization current on the working

electrode and monitor the polarization potential as a function of time. The polarization
duration (Total Time) can be set by the user, or you can also let the experiment be
automatically terminated when the polarization potential or quantity of electric charge reaches
to a certain value.

OCP (V) will display the current open circuit potential of the cell (update per second).

Experiment Parameters
Applied Current is the current applied on the measured system. Positive value means

anodic polarization; negative value means cathodic polarization. This is the total current
applied, not the current density. Units of A, mA, A are available.

The Total Time determines the duration of the galvanostatic polarization process.
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Experiment Termination
If the Use E box is checked, the experiment of galvanostatic will be automatically

terminated once the polarization potential goes above the high value (2V in above dialog box
for instance) or below the low value (-2V in above dialog box for instance).

If Use Q is checked, the experiment of galvanostatic will be automatically terminated
once the total integral quantity of electric charge (coulombs) goes over maximum value or
below minimum value.

If the Disable is checked, the above two experiment termination prerequisites are
ineffective. The experiment will not be terminated until the total time is reached.
Axis Type

When the experiment is performed, the data will be displayed as specified by the Axis
Type. CorrView can be later used to display the data in other formats. For the experiment of
Galvanostatic, the axis type is “E-Time”.

5.4 Potentiodynamic

Experiments→ Stable Polarization →Potentiodynamic
For potentiodynamic, there are up to four individual polarization potential set points. The

scan starts from the “initial E” and goes through “vertex E #1”, “vertex E #2”, and finally
reaches “final E”. The “vertex E #1” and “vertex E #2” can be both chosen, partly chosen or
neither chosen. The scan can be stopped or reversed when current reaches to a certain value.
The logarithm of current is recorded as a function of potential.
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OCP (V) will display the current open circuit potential of the cell (update per second).

Experiment Parameters
If you check neither vertex E#1 nor vertex E#2, then the potential is scanned directly from

Initial E towards Final E. For example, if you enter “-0.1” (vs. OCP) in the initial E, and “0.1”
(vs. OCP) in the final E box, then the potential is scanned from cathodic polarization 100mV
to anodic polarization 100mV. When the polarization current density has already met the
condition to terminate the experiment before the potential reaches 100mV, the scan will stop,
and the polarization state will be cut off. If potential is “vs. OCP”, then negative value means
cathodic polarization, and positive value means anodic polarization.

Scan Rate: It can only be a positive value. Scan direction is determined by the sign of the
applied potential. Scan time = scan amplitude/scan rate. Total measuring time=∑ (|amplitude
of polarization potential of each segment|/scan rate)

Experiment Termination
If check “Stop scan”, when the polarization current density is higher than the maximum

value (e.g. 2mA/cm2) or lower than the minimum set value (e.g.-2 mA/cm2), the experiment
will be stopped automatically.

If check the “Reverse scan”, when polarization current reached the range that you set, the
scan direction will be reversed, from current potential to initial potential. If the current density
is lower than the minimum value you set during cathodic retrace scan, the scan will be
automatically stopped.

If neither is checked, the experiment will be conducted according to the potential settings.
Normally, to protect the working electrode from excessively high current, you can choose Stop
scan and set a maximum anodic current.
Axis Type

In the experiment of potentiodynamic, you can choose “E vs. Logi”.
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Passivation curve
In potentiodynamic test, sometimes we need to measure passivation curves of some

metals such as chromium, nickel, cobalt and their alloys in certain medium. It will produce a
layer of passivation film on the surface of these metals when their potential is relatively
positive. At this moment, they are similar to noble metals in behavior, with slight passivation
current flowing. In order to evaluate their anti-corrosion performance, it is necessary to obtain
the cracking potential and protection potential. Therefore, the passivation curve is graphed.

Typical passivation curve

When the polarization potential is scanned towards positive to a certain value, the
passivation film will be cracked, then the polarization current will increase rapidly, this
polarization potential is called cracking potential φb. When the current exceeds a certain value
(eg. 100A/cm2), the potential will immediately be scanned towards negative, there will be a
hysteresis loop on the polarization curve. The intersection of the positive curve and the flyback
curve is considered to be the protection potential of the metal in this medium φp.

5.5 Galvanodynamic

Experiments →Stable Polarization →Galvanodynamic
For technique of galvanodynamic, there are up to four individual polarization current set

points. The scan starts from the “initial current” and goes through “vertex i #1”, “vertex i #2”,
and finally reaches “final i”. The “vertex current #1” and “vertex current #2” can be both,
partly or neither checked. The scan can be stopped or reversed when potential reaches a
certain value.
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OCP will display the current open circuit potential of the cell (update per second).

Experiment Parameters
If you check neither vertex i#1 nor vertex i#2, then the current is scanned directly from

Initial i towards Final i. For example, if you enter “-100” (unit:μA) in the initial i, and “100”
in the final i box, then the current is actually scanned from cathodic polarization 0.1mA to
anodic polarization 0.1mA. Of course when the polarization potential has already entered the
range to terminate the experiment before current reaches 0.1mA, the scan will stop, and cut off
the polarization state of the potentiostat.

Negative value means cathodic polarization, and positive value means anodic
polarization.

Scan Rate: It can only be a positive value. Scan direction is determined by the sign of the
applied current.
Experiment Termination

If check the “Stop scan”, when the final current is reached or the polarization potential
meets the condition to terminate the experiment, the scan will be automatically stopped.

If check the “Reverse scan”, when polarization potential reaches the range that you set,
the scan direction will be reversed, from the current current to initial current, and when the
polarization potential is lower than the minimum value you set, the scan will stop.

If neither is checked, the experiment will be conducted according to the current settings.

Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.

5.5 Multi Potential Steps
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Experiments→ Stable Polarization→Potential Sweep Steps
In Potential Sweep Steps, the instrument alternates between six potential sweeps and six

potential steps, somewhat like an arbitrary waveform generator. The following diagram shows
the potential waveform applied as a function of time. One can skip any segment by setting
parameters sufficiently small, allowing enhanced flexibility for waveform control. Current is
recorded as a function of time; for sweep segments, it can also be presented as a function of
potential.

Segment Parameters Range Remarks

1, 3, 5, 7, 9, 11 Init E /V -10~10 Initial potential in sweep segment

Final E /V -10~10 Final potential in sweep segment

Scan rate /V·s-1 1E-6~50 Potential scan rate in sweep
segment
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2, 4, 6, 8, 10,12 Step potential /V -10~10 potential value in step segment

Step time /s 0~10000 duration of step segment

1~12 Step potential/V vs. RE or vs.
OCP

choose the potential output mode

Data Acquisition
If Frequency (Hz) is chosen, the acquisition rate in points/second is specified.

Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.

6. Transient Polarization
6.1 Multi-Potential Steps

Experiments→ Transient Polarization→ Multi-potential Steps
In the Multi-potential Steps technique, up to twelve potential steps can be applied and

cycled. Current is recorded as a function of time.
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.

Experiment Parameters
The steps start from the Initial E, then to Step 1E, Step 2E, Step 3E, …towards Final E. If

the time of a step is “0” or the box before it is unchecked, this segment will be skipped.
Potential can be specified as “vs. OCP” or “vs. RE”.
Cycles specifies how many times the potential is stepped between Initial E and Final E.
Time determines the duration of the step potential being held.

Axis Type
Axis Type is I vs. time for multi-potential steps.

6.2 Multi-Current Steps

Experiments→ Transient Polarization →Multi-Current Steps
In the Multi-Current Steps technique, up to twelve current steps can be applied and cycled.

Potential is recorded as a function of time.
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will be “Not Available”.
Multi-Current Steps Parameters

The steps start from the Initial i, then to Step 1i, Step 2i, Step 3i, …towards Final i. If the
time of a step is “0” or the box before it is not checked, this segment will be skipped.

Cycles specifies how many times the current is stepped between Initial i and Final i.
Time determines the duration of the step current being held.

Data Acquisition
If Frequency (Hz) is chosen, the acquisition rate is set as Points/Second.

Axis Type
Axis type for multi-current steps is E vs time.

6.3 Potential Stair-Step (VSTEP)

Experiment→Transient Polarization→Potential Stair-Step
Potential Stair-Step can be used to measure the solution resistance Rs and polarization

resistance Rp, it can also be applied to calculate the double-layer capacitance Cdl.
There are up to 3 individual potential setpoints for potential Stair-step. If the Use box is

checked, the mode of the stair step is Initial E→Step1 E→Step2 E to finish two segments of
stair step measurement.
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will be “Not Available”.
Experiment Parameters

The steps start from Initial E, to Step E1, and then to Step E2. If “Use” box is unchecked,
the segment of the Step E2 will be skipped.

Time determines the holding time of a step potential.
Data Acquisition

If Frequency (Hz) is chosen, the acquisition rate in points/second is specified. Because
the step process is fast, the data acquisition rate is also fast, 1~3kHz is recommended.
Axis Type

Axis Type is I vs. time.
Pstat/Gstat(ECS)

In step test, because the measuring time is very short, the current range should only be
chosen manually in advance, not determined by the software automatically.

.
6.4 Galvanic Stair-Step (ISTEP)

Experiments→Transient Polarization→Galvanic Stair-Step
There are up to 3 individual current setpoints for galvanic Stair-step. If the Use box is

checked, the mode of the stair step is Initial current→Step1 E→Step2 E to finish two segments
of stair step measurement.
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will be “Not Available”.
Scan Parameters

The steps start from the Initial Current, to Step i#1, and then to Step i#2. If the “Use” is
not checked, the segment of the Step i #2 will be skipped.

The Time determines how long the current will be held at each step.
Data Acquisition

If Frequency (Hz) is chosen, the acquisition rate in points/second is specified. Owing to
the fast process of step, the data acquisition rate is fast too. The frequency is normally set
between 1~3KHz.
Axis Type

When the experiment is performed, the data will be displayed as specified by the Axis
Type. CorrView can be later used to display the data in other formats.

7. Chrono Techniques
7.1 Chronopotentiometry

Experiments→ Chrono Techniques→ Chronopotentiometry
In Chronopotentiometry (CP), two current levels can be specified to pass through the

working electrode, with the switching between the two dictated by time or potential. Potential
is recorded as a function of time.
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.

Experiment Parameters
Cathodic/anodic current is applied on the working electrode during the test. You can

choose the unit of the current.
Cathodic/anodic time is the duration of the applied cathodic / anodic current. Second,

minute and hour can be selected.
Num. of segment specifies how many times the current is cycled between cathodic and

anodic current. When the number of current polarity switches (segments) is reached, the
experiment stops.

Parameters Range Description

Cathodic current -2A~+2A The cathodic current applied on the working electrode

Anodic current -2A~+2A The anodic current applied on the working electrode

Cathodic time >0 Duration of cathodic current

Anodic time >0 Duration of anodic current

Initial polarity Anode/

cathode

The polarity at the beginning of the experiment

Num. of segment >0 The number of applied cathodic and anodic current
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Current Polarity Switching
It’s used to switch the anodic and cathodic polarization process. For example, as shown in

above parameters setting dialog box, if the potential reaches 1V in less than 10s, the polarity
will be switched, proceeding the cathodic polarization. If the potential reaches -1V in less than
10s, anodic polarization is triggered.
Data Acquisition

If Frequency(Hz) is chosen, the acquisition rate in points/second is specified.
Axis Type

When the experiment is performed, the data will be displayed as specified by the Axis
Type. CorrView can be later used to display the data in other formats.

7.2 Chronoamperometry

Experiments→Chrono Techniques→Chronoamperometry
Chronoamperometry method measures the current response as a function of time after

applying a single or dual potential step on the working electrode. Electrodes of fixed area are
often used in this method. This method is used to study the electrode process of coupling
chemical reaction, especially the reaction mechanism of organic electrochemistry.

In Chronoamperometry (CA), the potential is stepped from Init. E to either High E or Low
E depending on the Init. P/N and may then be stepped back.

OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.

Parameters setting
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The experiment starts at the Initial E, sweeps to High E, and then to Low E. The potential
can be specified in several ways. If “vs. OCP” is chosen, the specified potential is added to the
open circuit potential of the cell. If “vs.RE” is chosen, an exact potential is applied.
Pulse width specifies how long the potential is sustaining.
Number of Steps specifies how many potential cycles are formed between High E and Low E.

Parameters Range Description

Initial E (V) -10~10 Initial potential

High E (V) -10~10 Upper limit of potential step applied on the WE

Low E (V) -10~+10 Lower limit of potential step applied on the WE

Pulse width (s) >0 potential pulse width

Number of steps >0 Number of potential steps
.

Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.

7.3 Chronocoulometry

Experiments→Chrono Techniques→Chronocoulometry
Chronocoulometry is a method to measure the quantity of electric charges as a function of

time after a potential step is applied on the working electrode. It can study electrode process in
all kinds of coupling reactions. It can also study the electroactive substance adsorption.

A fast-rising potential pulse is applied on the working electrode of an electrochemical cell.
The current flowing through this electrode is measured and integrated, reporting coulombs as a
function of time. Technique is also referred to as CC.
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.

Parameters setting

Parameters Range Description

Initial E (V) -10~+10 The potential applied on the working electrode

Final E (V) -10~+10 The potential applied on the working electrode

Pulse width(s) 0.001~10 Duration of the applied potential pulse

Number of steps >0 Number of potential steps

The potential may be swept between up to 2 separate setpoints in this experiment. The
experiment starts at the initial potential, and then to the final potential. A potential can be
specified in several ways. If “vs. OCP” is chosen, the specified potential is added to the open
circuit potential of the cell. “vs.RE” is chosen to select an exact potential to be applied.

Pulse width specifies how long the potential is sustaining.
Number of steps specifies how many times the potential is cycled between Initial E and

Final E.
Data Acquisition

If Frequency (Hz) is chosen, the acquisition rate in points/second is specified.
Axis Type

When the experiment is performed, the data will be displayed as specified by the Axis
Type. CorrView can be later used to display the data in other formats.

8. Voltammetry
8.1 Cyclic Voltammetry

Experiments →Voltammetry →Cyclic Voltammetry
CV technique is used for the theoretical study of redox couples. Cyclic Voltammetry is a

special LSV that performs a triangular wave scanning on the working electrode. The potential
is linearly swept from Initial E to High E (or Low E, depending on the Initial P/N polarity
parameter). The potential is then swept back in the reverse direction.

CV curve usually consists of two parts: 1) the lower reduction/cathode part where the
reduction waveform is generated from reduction process of the oxidation state of the
electroactive material, 2) and the upper oxidation/anode part where the oxidation waveform is
generated from oxidation process of reduction products. CV technique can directly measure
the ratio of anodic peak current/cathodic peak current and the difference between anodic peak
potential and cathodic peak potential.

CV technique is mainly used for basic electrochemical theoretical study, such as the
electrode process, the absorption phenomenon of electrode etc.

For reversible system, if the cathodic reduction products are stable, then ipc / ipa=1.
To judge the reversibility of electrode process, the following formulas are employed:

1/2
28.25

paE E
n

 
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Where Epa = anodic peak potential

n
EE pc

25.28
2/1 

Epc= cathodic peak potential.

n
EEE PCpap

5.56


Note:△Ep is related to the reversing potential during CV scan. If n=1, and the reversing
potential is -100mV vs. Epc, the △Epwill be 59mV. △Ep is also associated with the experiment
environment, the value is in the range of 55~65mV(n=1), we can judge it as a reversible
process.

There are three individual setting points of potential. If use “initial E”, then the potential is
scanned from “initial E” to “step 1 E”, to “step 2E”, and back to initial E, cyclically.

Parameters setting dialog box
OCP displays the current open circuit potential of the cell (update per second).
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Scan Parameters

Parameters Range Description

Initial E(V) -10~10 Initial potential of scan

Step 1E(V) -10~10 Initial potential of the scan (not checking “Use”)

or the first vertex potential

Step 2 E(V) -10~10 the second vertex potential of the scan

Scan rate (mV/s) 10-3~107 The scan rate of the potential

Cycles >0 The number of the cycles

Interval (mV) > 0.001 Potential difference between two sampling points

Frequency (Hz) 0.01~1000 Sampling as per frequency,

Either Interval or Frequency should be chosen.

The potential may be swept between up to 3 separate setpoints in this experiment. The
experiment starts at the Initial E, sweeps to Step 1E, to Step 2 E, and then back to the Initial E.
Check “Use” to turn on or turn off the Initial E setpoint.

CV curve of glassy carbon electrode in K4[Fe(CN)6] solution

Axis Type:
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.

8.2 Linear Sweep Voltammetry

Experiments→Voltammetry→Linear Sweep Voltammetry
In Linear Sweep Voltammetry (LSV), the potential is scanned from Initial E toward Final

E. The following diagram shows the potential waveform applied as a function of time. Current
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is recorded as a function of potential. Normally, the scan rate of the instrument can be from
several mV to 1V per second.

OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will be “Not Available”.
Scan Parameters

Parameters Range Description

Initial E(V) -10~10 Initial potential of scan, “vs. OCP” can be chosen.

Final E(V) -10~10 Final potential

Scan rate(mV/s) 10-3~107 The scan rate of the potential

Interval (mV) > 0.001 Potential difference between two sampling points

Frequency (Hz) 0.01~1000 Sampling as per frequency,

Either Interval or Frequency should be chosen
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Up to 2 separate potentials can be set during the experiment. The scan starts at the Initial
E, and to the Final E.

If the Initial/Final E is “vs. OCP”, and you enter “0.2” in initial E, it means the scan is
from the potential OCP+0.2V. Positive value means anodic polarization, and negative value
means cathodic polarization.

If the Initial/Final E is “vs. RE”, and you enter “0.2” in initial E, it means the scan starts
from0.2V, which has nothing to do with OCP.
Axis Type

When the experiment is performed, the data will be displayed as specified by the Axis
Type. CorrView can be later used to display the data in other formats.

8.3 Staircase Voltammetry

Experiments →Voltammetry →Staircase Voltammetry
In Staircase Voltammetry (SCV), the potential is incremented from Initial E toward Final

E, and it may be scanned back. Current is sampled after every potential increment and
recorded as a function of potential. The following diagram shows the potential waveform
applied as a function of time.
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.

Scan Parameter

Parameters Range Description

Initial E(V) -10~+10 Initial potential of scan.

Final E(V) -10~+10 Final potential

Inc. E(V) 0.001~0.05 Incremented potential of each step

Cycles 1~10,000 The number of cyclic staircase waveform

Sample
width(ms)

1~ half of step period Data sampling width for each point

Step period(s) 0.001~100 Potential step period or dropping time
Initial E and Final E should be at least 0.01 V apart. If the sampling width is over half of

the step period, there will be prompt from the software to adjust the sampling width within
range. Data will be acquired at the end of each step. In general, potential is chosen to be vs.
RE.
Data Acquisition

If Frequency(Hz) is chosen, the acquisition rate in points/second is specified.
Axis Type

When the experiment is performed, the data will be displayed as specified by the Axis
Type. CorrView can be later used to display the data in other formats.
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8.4 Square Wave Voltammetry

Experiments→Voltammetry→Square Wave Voltammetry
In Square Wave Voltammetry (SWV), the base potential is incremented from Init E

towards Final E. A square wave potential is superimposed onto the base potential, which
increments after each cycle of the square wave. Current is sampled at the second half of the
forward and reverse steps. The current difference is recorded as a function of the base
potential. The following diagram shows the potential waveform applied as a function of time
and the current sampling scheme.

OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will be “Not Available”.
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SWV curve in K3Fe (CN)6system

Scan Parameters

Parameters Range Description

Initial E (V) -10~10 Initial potential of scan.

Final E (V) -10~10 Final potential

Inc. E (V) 0.001~0.05 Incremented potential of adjacent two square wave

Amplitude (V) 0.001~0.5 The amplitude of each square wave

Frequency(Hz) 1~100,000 Square wave output frequency
Initial E and Final E should be at least 0.01V apart. “vs. RE”is usually chosen to specify

the exact potential range.
Inc.E is the increment potential of each pulse; it can be chosen from 0.001V to 0.05V.
Amplitude can be chosen from 0.001V to 0.5V.

Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.

8.5 Differential Pulse Voltammetry

Experiments→ Voltammetry→ Differential Pulse Voltammetry
In Differential Pulse Voltammetry (DPV), the base potential is incremented from Init E

toward Final E.A potential pulse is applied. Current is sampled before the potential pulse and
at the end of the pulse. The difference between these two current samples is recorded as a
function of potential. The following diagram shows the potential waveform applied as a
function of time and the current sampling scheme.
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For the reversible system, the curve is symmetric, and the peak current and the measured
substance concentration is proportional. When the amplitude of the pulse is small, the
relationship can be expressed by the following equation:

C
t
DEA

RT
FnIP

m


4
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Where, E is the amplitude, A is the electrode area, tm is the interval of pulse applying
and current sampling. D is the diffusion coefficient of the measured material. From the
equation, we see the peak current is related to pulse amplitude. But too large amplitude will
influence the resolution. Generally, 25~50mV in amplitude and 5mV/s in scan rate are
suitable.

DPV technique can effectively eliminate the effect of the background current, which
enhances sensitivity dramatically. The minimum measured concentration can be as low as
10-8mol/L.

There is relationship between peak potential (Ep) of DPV curve and polarograph
half-wave potential(E1/2) as follows:

22
1

EEEp




There is a useful parameter, the half-peak width(W1/2) when I=IP/2. When the amplitude is
relatively small,

nF
EW 

 52.3
2

1 ,

Measuring the W1/2 can be a supporting measure to calculate the number of transferred
electron in reactions.
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.

DPV curve in K3Fe(CN)6system

Scan Parameters

Parameters Range Description

Initial E(V) -10~10 Initial potential

Final E(V) -10~10 Final potential

Inc. E(V) 0.001~0.05 Incremented potential of adjacent two pulses

Amplitude(V) 0.001~0.5 Potential pulse amplitude

Pulse width(s) 0.001~10, or less than Potential pulse width
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half of the pulse
period

Pulse period(s) 0.01~50 Potential pulse period or dropping time

Sample width(ms) 1~ half of pulse width Data sampling width

Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in any of the other formats.

8.6 Normal Pulse Voltammetry

Experiments→Voltammetry→Normal Pulse Voltammetry
In Normal Pulse Voltammetry (NPV), the base potential is held at Init. E, and a sequence

of potential pulses with increasing amplitude is applied. The current at the end of each
potential pulse is sampled and recorded as a function of the pulse potential. The pulse always
starts from the initial potential. In such a way a discrete, digitized curve is obtained. The initial
potential is a very important parameter. It determines the electrode surface state before the
Faraday current flows.
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will be “Not Available”.

Scan Parameters

Parameters Range Description

Initial E(V) -10~10 Initial potential

Final E(V) -10~10 Final potential

Inc. E(V) 0.001~0.05 Incremented potential of adjacent pulses

Pulse width(s) 0.001~10, or less than half
of the pulse period

Potential pulse width

Pulse period(s) 0.01~50 Potential pulse period or dropping time

Sample width(ms) 1~ half of pulse width Data sampling width
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Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in any of the other formats.

8.7 Differential Normal Pulse Voltammetry

Experiments→Voltammetry→Differential Normal Pulse Voltammetry
In DNPV, the base potential is held at Initial E, and a sequence of dual potential pulses is

applied. The magnitude of the first pulse increments after every iteration, and the second pulse
has a constant amplitude relative to the first. Current is sampled at the end of both potential
pulses, and the difference of these two values is recorded as a function of the first pulse
potential. The following diagram shows the potential waveform applied as a function of time
and the current sampling scheme:

OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will be “Not Available”.
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Scan Parameters

Parameters Range Description

Initial E(V) -10~10 Initial potential

Final E(V) -10~10 Final potential

Inc. E(V) 0.001~0.05 Incremented potential of adjacent pulses

Amplitude(V) 0.001-0.5 Potential pulse amplitude

1st pulse width(s) 0.001~0.02 First potential pulse width

2nd pulse width(s) 0.001~0.02 Second potential pulse width

Pulse period(s) 0.05~50 Potential pulse period or dropping time

Sample width(ms) 1~half of pulse width Data sampling width
Init E and Final E should be at least 0.01V apart.

Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.

8.8 A.C. Voltammetry

Experiments→Voltammetry→A.C. Voltammetry
In A.C. Voltammetry, the base potential is incremented from Initial E to Final E, and a

sequential sine waveform is superimposed. Current is sampled when the AC signal is applied,
and it is analyzed by using a software lock-in amplifier. During the experiment, only the
absolute AC current is displayed.
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.
Scan Parameters

Parameters Range Description

Initial E(V) -10~10 Initial potential

Final E(V) -10~10 Final potential

Inc. E(V) 0.001~0.05 Potential difference between adjacent waves

Amplitude (mV) 1~500 AC amplitude of each waveform

AC frequency (Hz) 0.1~10000 AC frequency

Bias DC Off-range-On Enable DC current bias during run

Sample period(s) 1~50 Data sampling period or dropping time
Initial E and Final E should be at least 0.01V apart.
Inc. E is the increment potential of each pulse; it can be chosen from 0.001V to 0.05V.
When the AC frequency is 2Hz or lower, the sample period parameter should be at least 2
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seconds.
Bias DC Current, check off or on, enables DC current bias during run.

Data Acquisition
If Frequency(Hz) is chosen, the acquisition rate in points/second is specified.

Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.

8.9 2nd Harmonic A.C. Voltammetry

Experiments→Voltammetry→2nd Harmonic A.C. Voltammetry
In Second Harmonic AC Voltammetry, the base potential is incremented from Initial E

toward Final E, and a sequential sine waveform is superimposed. Current is sampled when the
AC signal is applied, and its second harmonic component is analyzed by using a software
lock-in amplifier. During the experiment, only the absolute second harmonic AC current is
displayed.

OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.

Scan Parameters

Parameters Range Description

Initial E(V) -10~ 10 Initial potential

Final E(V) -10~10 Final potential

Inc. E(V) 0.001~ 0.05 Potential difference between adjacent waves
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Amplitude (mV) 1~500 AC amplitude of each waveform

AC frequency (Hz) 0.1~5000 AC frequency

Bias DC current Off-range-On Enable DC current bias during run

Sample period(s) 1~50 Data sampling period or dropping time

8.10 Fourier TransformAC Voltammetry (FTACV)

Experiments→Voltammetry→ Fourier Transform AC Voltammetry
For FTACV, the way of testing, parameters setting and data acquisition are the same as

ACV. The difference lies in post-processing of the data. After the test, the software will
automatically do the Fourier conversion with the original data, meanwhile obtaining the 2nd,
3rd, 4th, 5th, and 6th harmonics ACV data.

Experiment parameters
Parameter Range Description

Initial E(V) -10~+10 Initial potential

Final E (V) -10~+10 Final potential

Inc. E (V) 0.001~0.05
Potential difference between adjacent waves

Amplitude (mV) 1~2500
AC amplitude for every waveform

AC frequency(Hz) 0.1~5000
AC frequency

Bias DC current Off-range-On
Superimpose bias DC current on AC signal
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Sample period (s) 1~50
Time of sampling

Initial E and Final E should be at least 0.01 V apart.
For parameter of Bias DC current, the user can choose among Off, Below 1Hz, Below

100Hz, On.

9. Amperometric
9.1 Differential Pulse Amperometry (DPA)

Experiments→Amperometric→Differential Pulse Amperometry (DPA)
In Differential Pulse Amperometry (DPA), a conditioning potential can be applied for

electrode conditioning, during which current is not sampled. Two potential pulses are applied
after the conditioning step, and the current at the end of each pulse is recorded as a function of
time.
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Parameter setting window for DPA

Experiment parameters

Parameters Range Description

Initial E(V) -10~10 initial potential

Initial pulse width (s) ≥0 The duration of the initial potential. No data acquisition

Conditioning E(V) -10~10 The electrode conditioning potential

Time(s) ≥0 The duration of the conditioning potential. Current is not
sampled.

1st pulse potential(V) -10~10 The 1st pulse potential in each cycle.

1stpulse width (s) 0.01~100 The duration of the 1st pulse potential. Current is sampled.

2ndpulse potential (V) -10~10 The 2nd pulse potential in each cycle.

2ndpulse width (s) 0.01~100 The duration of the 2nd pulse potential. Current is sampled.

Cycles 10~100,000 The total number of cycling.

Sample width(ms) 1~ half of
pulse width

The sampling width of the 1st and 2nd pulse potential in each
pulse.

9.2 Double Differential Pulse Amperometry (DDPA)

Experiments→Amperometric→Double Differential Pulse Amperometry (DDPA)
Double Differential Pulse Amperometry (DDPA) alternates between two instances of

differential pulse amperometry, with two sets of data recorded and displayed. In each instance,
a conditioning potential applied for electrode conditioning, during which current is not
sampled. Two potential pulses are applied after the conditioning step, and the current at the
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end of each pulse is recorded as a function of time. During the experiment, only the difference
between the two current samples is displayed.

Parameter setting window for DDPA

Experiment parameters
Parameter Range Description

Initial E(V) -10~10 Initial potential

Initial pulse width (s) ≥0 Duration of the initial potential. The current is not sampled.

1st Conditioning E(V) -10~10 the 1st cleaning potential

1st Conditioning T(s) ≥0 The duration of the 1st cleaning potential. Current is not
sampled.

1st pulse E (V) -10~10 The 1st pulse potential in each cycle

1st pulse width(s) 0.01~100 The duration of the 1st pulse potential. Current is sampled.

2nd pulse E (V) -10~10 The 2nd pulse potential in each cycle
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2nd pulse width(s) 0.01~100 The duration of the 2nd pulse potential in each cycle. Current is
sampled.

2nd Conditioning E(V) -10~10 The 2nd cleaning potential of the experiment

2nd Conditioning T(s) ≥0 The duration of the 2nd cleaning potential. In this process the
current is not sampled

3rd pulse E(V) -10~10 the 3rd pulse potential in each cycle

3rd pulse width (s) 0.01~100 The duration of the 3rd pulse potential in each cycle. Current is
sampled.

4th pulse E (V) -10~10 The 4th pulse potential in each cycle

4th pulse width(s) 0.01~100 The duration of the 4th pulse potential in each cycle. The
current is sampled in this process.

Cycles 10-100,000 Total number of cycling

Sample width(ms) 1~half of
pulse width

The sampling width of pulse potential 1,2,3,4.

9.3 Triple Pulse Amperometry (TPA)

Experiments→Amperometry→Triple Pulse Amperometry (TPA)
In Triple Pulse Amperometry (TPA), three potential pulses are applied. The first two

pulses are for electrode conditioning. Current is sampled at the end of the third potential pulse
and recorded as a function of time. The third potential pulse can be constant or incremented
after each cycle.
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8.3.1 Experiment parameters

Parameter setting window for TPA

Parameter Range Description

Initial E(V) -10~10 The initial potential

Initial pulse width (s) ≥0 The duration of the initial potential. The current
is not sampled.

Final E(V) -10~10 The final potential

1st pulse E(V) -10~10 the 1st pulse potential in each cycle

1st pulse width(s) ≥0 The duration of the 1st pulse potential in each
cycle.

2nd pulse E(V) -10~10 The 2nd pulse potential in each cycle

2nd pulse width(s) ≥0 The duration of the 2nd pulse potential in each
cycle. The current is not sampled.

3rd pulse E(V) -10~10 the 3rd pulse potential in each cycle

3rd pulse width(s) 0.01~100 The duration of the 3rd pulse potential in each
cycle. The current is sampled.

Pulse inc. E(V) 0~0.02 Potential difference of the 3rd pulse of adjacent
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cycles

Cycles 10-100,000 Total number of cycling

Sample width(ms) 1~ half of 3rd

pulse width
The sampling width of the 3rd pulse potential in
each cycle

9.4 Integrated Pulse Amperometric Detection (IPAD)

Experiments→Amperometric→Integrated Pulse Amperometric Detection (IPAD)
In Integrated Pulse Amperometric Detection (IPAD), six segments of potential sweeps or

steps are applied. Current is sampled and integrated during the first four segments. Electrode
conditioning or cleaning occurs during the last two steps. The integrated current is averaged
and recorded as a function of time.

8.4.1 Experiment parameters

Parameter setting window for IPAD

Parameters Range Description
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Initial E(V) -5~5 The initial potential

Initial pulse
width(s)

0.05~1 Duration of initial potential (current is sampled and
integrated for the last 10ms)

Peak E(V) -5~5 Peak potential

1st scan time(s) 0.1~1 Scan time from Initial E to peak E; The current is
sampled and integrated.

Return E(V) -5~5 Return potential in each cycle

2nd scan time(s) 0.1~1 Scan time from peak E to Return E; The current is
sampled and integrated.

Hold E(V) -5~5 Hold potential of each cycle

Hold Time(s) 0.05~1 Duration of hold potential (current is sampled and
integrated for the first 10ms)

Oxd. E(V) -5~5 Oxidation potential for electrode treatment

Oxd. Time(s) 0.05~1 Oxidation time duration; The current is not sampled

Red. E(V) -5~5 Reduction potential for electrode treatment

Red. Time(s) 0.05~1 Reduction time duration. The current is not sampled

Cycles 5-100,000 Total number of cycling

10. Stripping Voltammetry
10.1 Potentiostatic Stripping

Experiments→Stripping Voltammetry→Potentiostatic Stripping
In Potentiostatic Stripping, a constant potential deposition step is first applied, after which

the species accumulated at the electrode surface are stripped out by applying a constant current.
Potential is recorded as a function of time.
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.

Parameters Range Description

Conditioning E(V) -10~10 Cleaning/conditioning potential

Conditioning T(s) ≥0 Cleaning potential duration; the current is not sampled

Deposition E(V) -10~10 Deposition potential is usually 0.3~0.5V more negative than the
redox standard potential, which makes it easy to reduce the
tested metal ions.

Deposition Time(s) ≥0 The time of the deposition process

Quiet Time(s) ≥0 Waiting time between deposition and stripping

Stripping I (mA) Constant current is applied on the working electrode.

Deposition Time(s) >0 the time of potentiostatic stripping process

Data Acquisition
If Frequency(Hz) is chosen, the acquisition rate in points/second is specified.

Axis Type:
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.

10.2 Linear Stripping Voltammetry
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Experiments→Stripping Voltammetry→Linear Stripping
Voltammetry stripping technique is a high-sensitivity electrochemical method for trace

elements analysis. In Linear Stripping, a constant potential deposition step is first applied.
After that, the species accumulated on the electrode surface are stripped out by applying a
linear potential, which is scanned from an initial potential to a final potential that progresses at
a defined scan rate.

OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.

Parameter Range Description

Conditioning E(V) -10~10 Cleaning/conditioning potential

Conditioning T(s) ≥0 Cleaning potential duration; the current is not
sampled.

Deposition E(V) -10~10 Deposition potential is normally 0.3~0.5V more
negative than the redox standard potential, which
makes it easy to reduce the tested metal ions.

Deposition Time(s) >0 The time of the deposition process

Quiet Time(s) >0 Waiting time after deposition and before stripping

Initial E(V) -10~10 Initial potential in stripping

Final E(V) -10~10 Final potential in stripping

Scan Rate(mV/s) 0.01~1000 Scan rate in stripping process
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Deposition Parameters
Before the experiment, the surface of working electrode needs cleaning by this

conditioning step.
A constant potential deposition step is applied to accumulate species on the working

electrode surface. This potential can be specified to choose either “vs. OCP” or “vs. RE”.
The deposition time determines how long the potential will be held at this step. After

deposition, the experiment can be quiet for some time.
Linear Stripping Parameters

A potential can be specified in several ways. If “vs. OCP” is chosen, the specified
potential is added to the open circuit potential of the cell. “vs.RE” means selecting an exact
potential.
Data Acquisition

If Frequency(Hz) is chosen, the acquisition rate in points/second is specified.
Axis Type

When the experiment is performed, the data will be displayed as specified by the Axis
Type. CorrView can be later used to display the data in other formats.

10.3 Staircase Stripping Voltammetry

Experiments→Stripping Voltammetry→Staircase Stripping
In Staircase Stripping, a constant potential deposition step is applied. After that the species

accumulated on the electrode surface are stripped out by applying a staircase potential, which
is incremented from Initial E toward Final E that progresses at a defined increment. It’s similar
to linear stripping. Staircase stripping is considered to be a derivative of linear sweep
stripping.
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.
Staircase Stripping Parameters

Before the experiment, the surface of working electrode needs cleaning by this
conditioning step.

A constant potential deposition step is applied to accumulate species on the working
electrode surface. This potential can be specified to choose either “vs. OCP” or “vs. RE”.

The deposition time determines how long the potential will be held at this step. After
deposition, the experiment can be quiet for some time.
Data Acquisition

If Frequency (Hz) is chosen, the acquisition rate in points/second is specified.
Axis Type

When the experiment is performed, the data will be displayed as specified by the Axis
Type. CorrView can be later used to display the data in other formats.

10.4 Square wave stripping Voltammetry

Experiments→ Stripping Voltammetry→ Square Wave Stripping
In square wave stripping voltammetry, the potential applied on the working electrode is

linearly varied in the mode of square-wave in stripping process. The stripping process applies
the technique of substantial differential, and the potential applied on the working electrode is
in the mode of a symmetric square wave being superimposed on a base step potential. High
sensitivity and fast scanning are its advantages, which reduces the analysis time.
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.

.
Deposition Parameters

Conditioning E: Before deposition, the conditioning potential is applied on working
electrode to remove impurities. working electrode surface state is automatically updated.

Conditioning T: the duration of conditioning potential.
Deposition E: Deposition potential is normally 0.3~0.5V more negative than the redox

standard potential, which makes it easy to reduce the tested metal ions.
Deposition time: the duration of deposition potential.
Quiet time: Stop stirring, the potential is not applied on the working electrode.

Square wave stripping Parameters
Initial E: the minimum potential for stripping process to begin.
Final E: final potential is generally higher than the oxidation potential of analyte ions.
Inc.E: the incremental potential of each step.
Amplitude: Square wave amplitude
The potential can be specified in several ways. If “vs. OCP” is chosen, the specified

potential is added to the open circuit potential of the cell. For example, “0.1V vs. OCP” means
applying a potential 0.1V above the open circuit potential. “vs. RE” means selecting an exact
potential.
Data Acquisition

If Frequency (Hz) is chosen, the acquisition rate in points/second is specified.
Axis Type

When the experiment is performed, the data will be displayed as specified by the Axis
Type. CorrView can be later used to display the data in other formats.
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10.5 Differential Pulse Stripping Voltammetry

Experiments→Stripping Voltammetry→Differential Pulse Voltammetry Stripping

OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.
Data Acquisition

If Frequency(Hz) is chosen, the acquisition rate in points/second is specified.
Axis Type

When the experiment is performed, the data will be displayed as specified by the Axis
Type. CorrView can be later used to display the data in other formats.

10.6 Normal Pulse Stripping Voltammetry

Experiments →Stripping Voltammetry→Normal Pulse Voltammetry Stripping
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.

Data Acquisition
If Frequency(Hz) is chosen, the acquisition rate in points/second is specified.

Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.

10.7 Differential Normal Pulse Stripping Voltammetry

Experiments→Stripping Voltammetry→Differential Normal Pulse Voltammetry Stripping
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OCP will display the current open circuit potential of the cell (update per second). If the
instrument is turned off, this value will display “Not Available”.

Data Acquisition
If Frequency(Hz) is chosen, the acquisition rate in points/second is specified.

Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.

11. Impedance(EIS)
11.1 EIS vs. Frequency(IMP)

Experiments →Impedance →EIS vs. Frequency
In EIS vs. Frequency technique, it measures the impedance spectroscopy of the

electrochemical system in difference frequency. Nyquist and Bode plot is obtained.
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OCP will display the current open circuit potential of the electrolytic cell (update per
second). It is useful for the users to judge whether the working electrode is stable for
impedance test.
File Name

The user should enter a file name to save data before starting the test. At the first time,
when You input a name and click OK, you will see the default data storage path on the top of
the testing window. Or you can click the Browse, and choose the storage path as you want.
This is particularly useful if you forget the file names that you already use.

CS Studio will automatically append the suffix “.z60” to a file name. For example, if you
input “tutor1”, the name of the data file will be shown as “tutor1.z60”.
Polarization

DC potential: the DC polarization potential of the working electrode during impedance
test. If the test needs to be conducted under open circuit potential, the user should enter “0”
and select “vs. OCP” here. At this moment, the potentiostat will automatically give an output
of OCP+ DC potential on the working electrode. For example, if you need to do the
impedance test under 50mV DC potential of anodic polarization, you can enter “0.05”.

If the test needs to be carried out at a certain potential (such as-0.5V vs. SCE), you can
select “vs. RE” and enter “-0.5”, then the potentiostat will polarize the working electrode to be
-0.5V.

AC amplitude is the amplitude of the electrochemical impedance excitation signals. For
example, E=0.012sin( t) V means AC signal amplitude is 12mV. Under high frequency, the
actual polarization amplitude of the working electrode may be lower than this value due to rate
limitation of the amplifier and high-frequency transmission loss of the conducting wires.
Frequency Sweep

The user should choose the mode of frequency sweep. Frequency sweep starts from the
initial frequency to the final frequency, and the mode can be both linear and logarithmic.

If you choose linear mode, the measured points will be evenly distributed between the
initial frequency and final frequency. For example, if the frequency range is from “1kHz to
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1Hz”, and you set “10” measured points, the frequencies will be “1Hz, 99.9Hz, 2×99.9Hz ...”
Generally, this mode is not usually selected unless for special requirements.

If you choose logarithmic, the sampling data points will be evenly distributed in
frequency logarithmic axis (Bode plot). It is particularly useful when frequency range is
between 2 to 5 orders of magnitude. For example, if the frequency range is from100kHz to
0.01Hz, and you set 10 points/10 decade, then the measured points will be evenly distributed
between initial and final frequency, 70 points in total. The users usually choose this mode.

Pstat/Gstat(ECS)
For regular electrochemical impedance system, in ground mode the “real” mode is

recommended. The bandwidth of filter can be 2.2pF~1μmF.

Analyzer

Current range
The user can set current range automatically/manually. If select “auto”, you need to set a

minimum current range in high frequency. In the above dialog for example, when the
measuring frequency is over 1000Hz, the auto current range will be no lower than 2mA.

The high frequency is defined by the user. In the above picture, f >1000Hz is high
frequency region, f <10Hz is low frequency region, and 10Hz ~1000Hz is middle frequency
region.

If auto current range cannot meet the need, then manual setting is recommended. For
example, in above picture, under manual setting, the current range is 2mA(f >1000Hz), 200μ
A (f <10Hz and f =10Hz ~1000Hz )

To improve measurement accuracy, the setting for current range should be varied. The
user should select suitable current range according to frequency band. In general, current

For low impedance
system, you can choose
2mA. For high
impedance system, you
can choose
20μA~200μA. If the
range is not properly set,
noise may appear on the
EIS plot.

For stable system, you
can select “off”. For
high impedance system
(e.g. coating), you can
choose 22~100pFto
reduce the noise of the
plot. But there may be a
small additional
capacitor ring in the
high impedance region
of the spectroscopy.
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range at low frequency should be smaller than that at high frequency. If the current range is set
inappropriately, the EIS plot may appear large noise. If the current range is changed frequently,
there will be obvious bent points on the curve. By observing signal amplitude of the waveform,
the user can judge if the current range is suitable.

Bandwidth
The higher the selected capacitance value is, the narrower the bandwidth of the

potentiostat will be. The performance in high-frequency will weaken, but stability will be
improved.

Bandwidth is set based on the critical frequency fc. If the measurement frequency is higher
than fc, normally you should choose a small capacitance (or turn it off) to avoid false
impedance spectra in high frequency region. But for high impedance system, it may result in
oscillation. You may have to increase the capacitance. To check if oscillation occurs, you can
observe the signal amplitude of the waveform.

Integration Time
The impedance measurement accuracy can be improved by increasing the integration time.

You can set the integration time to be the number of cycles or seconds. It specifies the time
spent on each frequency point. The longer the integration time is, the higher the measurement
accuracy will be, and the more time it will take.

Delay time is the waiting time between measurement of two frequency points.

The impedance spectroscopy analyzing
Impedance data file (.z60) is fully compatible with Zview software which is the tool to

analyze impedance spectroscopy and draw graphics. After data acquisition in impedance test,
you can click “Tools” → “EIS Analysis” or directly click Zview icon to analyze data.

11.2EIS vs Time(IMPT)

Experiments →Impedance → EIS vs. Time (IMPT)
IMPT measures the impedance characteristics of the electrochemical system as a function

of time at a fixed frequency. It tracks the dynamic processes of some systems, such as
conductivity.
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OCP will display the current open circuit potential of the electrolytic cell (update per
second). This is particularly useful for the user to judge whether the working electrode is
stable for impedance test.

Polarization
DC potential is the DC polarization potential of the working electrode during impedance

test. If the test needs to proceed under open circuit potential (OCP), then you can enter “0” and
select “vs. OCP”. At this moment the potentiostat will automatically give an output of the sum
of OCP and the DC potential to the working electrode. If you do the impedance test at anodic
polarization50mV DC potential, you can enter “0.05” here.

If the test needs to be carried out at a certain potential (such as-0.5V vs. SCE), you can
select “vs. RE” and enter “-0.5”. The potentiostat will polarize the working electrode to be
“-0.5V”, instead of “-0.5+OCP”.

AC amplitude is the amplitude of the electrochemical impedance excitation signals. For
example, E = 0.012 sin ( t) V means AC signal amplitude is 12mV. At high frequency, the
actual polarization amplitude of the working electrode may be lower than this value due to rate
limitation of the amplifier and high-frequency transmission loss of the conducting wires.
Time Scan

In Impedance~ Time scan, frequency of sine wave is constant. It measures the impedance
of some electrochemical systems at a frequency point as a function of time.

Interval - interval for measurement at each frequency point.
Total time- the total time of measurement.

Pstat/Gstat(ECS)
Click this button, and open the window for instrument setting. You can choose the

instrument model, set the switching way of current range, signal gain/loss, ground mode, filter
bandwidth, digital smoothing, quiet time (scan delay). For regular electrochemical impedance
measurement system, real ground mode is recommended, and 2.2pF~1μF is OK for filter
bandwidth.
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Cell Setting
You can enter related information of one or more working electrode(s) and electrolytic

cell(s), eg. surface area, material, and temperature... The electrode area, density and chemical
equivalent will affect the results of experiment and fitting. Temperature or type of RE will not
affect the original data; they are just saved in each data file for info. Meanwhile, these
parameters are needed for corrosion rate calculation.

11.3 EIS vs Potential (IMPE)

Experiments→ Impedance→ EIS vs. Potential
This method is used to measure impedance characteristics at different DC polarization

potential. The potential is stepped from initial potential to final potential. It can obtain
Mott-Schottky (M-S) plot which has been widely used to study the semiconductor
characteristics of passivation film on the metal. It can determine the carrier type, concentration
and the flat band potential of the semiconductor passivation film.

When the passivation film is in contact with the solution and the space charge of the
semiconductor passivation film is in the state of depletion, for the space charge capacitance
(Csc) and the measured voltage (Vm), there is the following linear relationship:

Where, Vfb is flat band potential, Nd and Na are the carrier concentration of donor and
acceptor respectively, ε is the relative permittivity, ε0 is the vacuum permittivity, A the
electrode surface area, k is Boltaman constant, T is absolute temperature, e is the quantity of
electric charge.

Passivation film is of a double layer structure. Because the composition and crystal
structure are different for the inner and outer layer of the passivation film, semiconductor type
is also different. Therefore, two space charge layers are formed inside the passivation film,
that is, the space charge layer on solution / passivation film interface, and the inner layer /outer
layer interface pn junction capacitance. Because pn and passivation film capacitance are small,
in the impedance ~ potential sweep, high-frequency sine wave is generally used for
measurement.
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OCP will display the actual open circuit potential of the electrolytic cell (update per
second). This is particularly useful for the user to determine whether the working electrode is
stable for impedance test.
EIS Parameters

Frequency and AC Amplitude specify the frequency and amplitude of sine wave during
the impedance measurement.
Potential Parameters

Initial E is the initial DC level of the working electrode in impedance ~ potential sweep.
Final E is the final potential in impedance ~ potential sweep.
Inc. E is the potential increment. Potential is increased with the form of steps.

Pstat / Gstat (ECS)
Click on this button, and open the window for instrument setting. You can choose the

instrument model, set the switching way of current range, signal gain/loss, ground mode, filter
bandwidth, digital smoothing, quiet time (scan delay). For regular electrochemical impedance
measurement system, real ground mode is recommended, and 10pF~100pF is OK for filter
bandwidth.
Cell Setting
You can enter related information of one or more working electrode(s) and electrolytic

cell(s), eg. surface area, material, and temperature... The electrode area, density and chemical
equivalent will affect the results of experiment and fitting. Temperature or type of RE will not
affect the original data; they are just saved in each data file for info. Meanwhile, these
parameters are needed for corrosion rate calculation.

12. Charging/Discharging
12.1Battery Charging/Discharging

Experiments→ Charging/Discharging → Battery Charging/Discharging
It is used to test the charge and discharge characteristics of rechargeable battery and its
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lifetime.

Experiment parameters
Charge current--According to different connecting ways of the electrodes, the sign of

charge current will be different. Connect the working electrode to anode, and the reference &
counter electrodes to the cathode, if the open circuit potential is positive, then a positive value
entering means charging process.

E-Threshold for C-V Conv. is the critical voltage where charge process is changed from
constant current mode to constant voltage mode. Normally in the early stage of charge, it is
constant current charge mode. Once the battery voltage is higher than the critical voltage, it
will convert to constant voltage mode. At this moment, the charge current will gradually
decrease with time. When it falls to the trickle current (usually 10% ~ 20% of the charge
current), the software will automatically stop charging.

Discharge current - Connect the working electrode to anode, and the reference & counter
electrode are connected to cathode, if the OCP is a positive value, then it means discharging if
you enter a negative value here.

Discharge threshold voltage - During discharge process, when the voltage drops to this
threshold voltage, the battery will stop discharge.

Quiet time - it specifies the interval from the state of charging to discharging. The battery
is in the open circuit during this time.

Charge/ Discharge time -When the charge/discharge time is reached, even the specified
threshold voltage hasn’t been reached yet, the charge / discharge process will stop, and turn to
discharge/charge. You can select second, minute or hour.

Cycles - a complete cycle includes a charging & discharging process. This parameter
specifies the total number of cycles throughout the experiment. When the number is reached,
the experiment will be stopped.
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12.2 Galvanostatic Charging/Discharging (GCD)

Experiments→ Charging/Discharging→ Galvanostatic Charging/Discharging
It measures cyclic charge-discharge characteristics of the electrode materials, such as

secondary battery or supercapacitor electrode material, under a constant current. It tests the
cycle lifetime of the electrode material.

Charge/Discharge Current
Charging I- if the anode is connected to the working electrode, entering a positive value

means charge.
Discharging I- if the anode is connected to the working electrode, entering a negative

value means discharge.

Condition for switch of Charging/Discharging
Based on Time
It specifies the duration of the process of charge /discharge. Charging process will be

stopped and it will turn to discharge if the charging time reaches the set value. After the time
of discharging, a cycle is finished. It will go to the charging process again. You can select
“seconds”, “minute” and “hour.”
Based on Time and E

Either condition is met, the charge/discharge process switch.
Cycles- a complete cycle includes a charge and a discharge process. It specifies the total
number of cycles conducted throughout the experiment. When this number is met, the
experiment will be stopped.
Capacity calculation
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Specific capacitance is calculated according to the following formula:

C= I t
m V



Where I is charging(discharging) current.  t is discharging(charging) time,  V is
discharging(charging) potential difference, m is the mass of electrode active materials (Please
note: m cannot be 0, otherwise the software will give an error prompt.)

Through many times of cyclic measurement, we can evaluate the lifespan of the
capacitors. By symmetry of the charging and discharging curve, we can judge whether
capacitor charging and discharge, and the electrochemical reactions are reversible or not.

Charge-discharge efficiency () is calculated according to:

dis

ch

C= %
C

 100
,
= 100%dis

ch

t
t







Where, Cch, Cdis is the charging capacitance and discharging capacitance, respectively.
 tch,  tdis is charging time and discharging time, respectively, they are displayed on the
software.

Excl. the first cycle - Normally error is relatively big for the data of the first cycle.You
can check it to not save the data of the first cycle.

12.3 Potentiostatic charge and discharge (PCD)

This technique aims to checking the charge and discharge characteristic of the battery,
and test the service life of the battery.

Charging Voltage (V): charge under a constant voltage.
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Discharging Voltage (V): discharge under a constant voltage. You can check the First
discharge to let the system be under discharge.

Charge / discharge switch conditions
Based on Time: You can set the time for each process. When the time is up it will change

from charge to discharge or from discharge state to charge.
Based on Current:When current meets the conditions for switch, it will go to a different

process.
Quiet time: the intervals when battery turns to discharge from charge. During the quiet

time the battery is under open circuit state.
Cycles: A cycle includes a charge and discharge process. When the number of

charge-discharge process reaches this number you set, the whole battery test will end.
Capacity calculation: Specific capacitance and specific energy not check as default.

After the test, you can find the related calculation result in the data .dat

13. Bipotentiostat

13.1Hydrogen Diffusion Test (HDT)

Experiments→ Bipotentiostat→ Hydrogen diffusion Test

CS2350 bipotentiostat can do hydrogen diffusion test.
Hydrogen Diffusion Test (HDT) requires a set of H-cell which consists of two cells

connected in serial. For each cell, there is a set of reference &counter electrode, and they share
a working electrode which is a thin metal plate clipped in the middle of the two cells. (See the
right picture).

On the hydrogen-charging surface of the working electrode, the square wave cathodic
current is applied. By alternatively changing the current value, the atoms will diffuse into the
metal and gradually reach the other side (detection surface) of the working electrode. By
measuring the amplitude of the current waveform and the delay time, the hydrogen diffusion
rate and diffusion coefficient can be calculated.

Connect the double electrolytic cells in the way as shown below, add 0.1mol/L NaOH
solution into the anodic cell (right cell). Connect the electrode cable to the main channel on
the front panel, and the cathodic cell to the slave channel. Firstly, set the anodic polarization
potential of the main channel to be 0.2V vs. Hg/HgO, then start the polarization. The anodic
current will decline dramatically at the beginning, then slowly remain a stable value, i.e. the
anodic residual current which is generated by the residual hydrogen inner the steel plate or the
impurities that can be oxidized in solution of the diffusion surface. When the residual current
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is lower than the set value, the user can add experimental medium (such as dilute
hydrochloricacid) into the cathodic cell, and then start galvanostatic polarization of the slave
channel. The initial current is the peak current, e.g. 10mA (see the figure). At this moment
hydrogen ions on cathodic surface of cathodic cell will be reduced to hydrogen atoms, some of
which will permeate into the metal disc and arrive on anodic surface of the anodic cell, then
these arrived hydrogen atoms will be oxidized into ions under anodic polarization in the main
channel, forming oxidation current.

Diagram for Hydrogen diffusion cells

Current vs time curve in hydrogen diffusion test

Because hydrogen atoms diffusion rate is limited, current at the hydrogen detecting side
delays, taking the form that anodic current increases (rising edge) or decreases (falling edge)
gradually with time. According to the delay time of the hydrogen detecting current and its
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value, we can calculate the hydrogen concentration and diffusion rate in the metal, and further,
we also can evaluate some inhibitors’ effect on hydrogen diffusion.

Hydrogen Atoms Oxidation (main channel)
Potential (V)— it is the polarization potential applied on the working electrode at the

hydrogen current detection side. This potential should make the working electrode (metal disk)
in anodic polarization. That is, a positive value should be entered to allow hydrogen atoms to
be oxidized to ions.
Hydrogen Ions Reduction (slave channel)

Please set peak current and valley current of the square wave of hydrogen charging
current as well as time. Hydrogen charging current can only be the cathodic direction so that
the hydrogen ions are reduced to be atoms and pass through the working electrode (metal disk
in the middle). Number of cycles of hydrogen charging current is the number of square wave.

Residual current: With the potentiostatic polarization going on, residual hydrogen
current in the metal will gradually decrease. When it is lower than the set residual current, the
software will start galvanostic polarization for hydrogen charging.

At the beginning, the main channel will firstly start potentiostatic polarization, letting the
hydrogen atoms in the metal fully diffuse onto the oxidation surface and be oxidized. It takes a
relatively long time. Normally when the residual current is lower than 1~2μA/cm²(threshold
of residual current), it’s considered that hydrogen atoms in the metal are totally oxidized. Once
the oxidation current is lower than the threshold value, the slave channel will start
galvanostatic hydrogen charging. Hydrogen charging current varies between the peak current
and the valley current. In general, 10~20 minutes later (depends on the material and thickness
of the metal), the anodic current detected in the main channel will increase gradually and
finally keep stable, as hydrogen atoms diffuse and reach to the opposite side of the metal and
are oxidized to form anodic current.
Data Acquisition

If Frequency (Hz) is chosen, the acquisition rate in points/second is specified.
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Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.
Main/Slave settings

For bipotentiostat, the “main channel” and “slave channel”settings can be same or
different. Please choose “real” in ground mode.

13.2Rotating ring-disk Electrode (RRDE)

Experiments → Bipotentiostat → Rotating ring-disk electrode
CS2350 bipotentiostat can conduct rotating ring-disk electrode.
Compared with stationary electrodes, the rotating disk electrode is more stable in terms of

concentration polarization. It has better polarization curve stability; and can measure rapid
electrochemical reactions. Therefore, measuring the polarization curve of the rotating disk
electrode has wide applications, especially in diffusion coefficient measurement, electron gain
&loss in reactions, the reactant concentration, leveling effect of electroplating additives, and
the kinetic parameters of electrode reactions, etc. With the help of ring electrode, it can also
detect reaction intermediate products on the disk electrode.

In the following picture, disk working electrode (DW)and ring working electrode (RW)
are two independent WE in concentric circle. DW and RW should be controlled at different
polarization potential to ensure that electrochemical reaction product on DW can arrive in ring
electrode for further redox reactions and be detected.

RRDE setup should be connected to the bipotentiostat with main channel (channel #1) and
the slave channel (channel #2). The 2nd channel controls the potential difference between DW
and RW.

The main channel applies the common three-electrode mode: CE clamp connects to the
counter electrode; RE clamp connects to the reference electrode; and WE clamp connects to
the disk electrode.
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The slave channel also applies three-electrode potentiostatic mode: WE clamp connects to
the ring electrode, CE clamp connects to the counter electrode, and RE clamp connects to the
reference electrode. That is, RE clamp and CE clamp of each channel connects to a common
reference electrode and counter electrode.

The intermediate product generated during disk electrode polarization further will be
oxidized or reduced on the ring electrode due to the potential difference between the ring-disk
electrode. Current on the ring electrode is measured and displayed by slave channel
potentiostat.

For RRDE test, the disk electrode is the main working electrode, and the ring electrode is
mainly used to detect the intermediate product on the disk electrode. Therefore,
potentiodynamic test is usually conducted on disk electrode, and the potential difference
between ring and disk electrode is set to be a constant value.

There are two groups of measured data: one is the polarized potential Ed and polarized
current Id on the disk electrode (main channel /channel 1). The second group is the polarized
potential Er(fixed) and the polarized current Ir on the ring electrode (2nd channel).

parameters setting for rotating ring-disk electrode test
Disk electrode scan parameters

Similar to potentiodynamic scan, up to 4 independent polarization potentials can be set on
disk electrode.
Ring electrode polarization

Potential —polarization potential of ring electrode vs. the disk electrode, with unit of V.
Data Acquisition

If Frequency (Hz) is chosen, the acquisition rate in points/second is specified.
Axis Type

When the experiment is performed, the data will be displayed as specified by the Axis
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Type. CorrView can be later used to display the data in other formats.
Main/Slave settings

For bipotentiostat, you need to do settings for the main & slave channel respectively.

14. Misc. Techniques
14.1Electrochemical Noise (EN)

Experiments→Misc.Techniques→Electrochemical
Noise

This method is mainly used to monitor noise
potential and the noise current (zero resistance current or
galvanic current) as a function of time. Monitoring
duration can be set.

For CS series electrochemical workstation, the noise
signals (or galvanic current) measurement is different
from other methods in that it doesn’t need to be in the state of polarization. In the
noise/galvanic current measurement, the working (galvanic) electrode Ⅰ is connected to the
green clamp of the electrode cable, and working (galvanic) electrodeⅡ is connected to the
black clamp, and the reference electrode is connected to the yellow clamp. (See the picture on
the right.)

Run the CS Studio software, select electrochemical noise measurement, on the software
dialog box, it will appear coupling potential and galvanic current. If the current value is
positive, it means the working /galvanic electrode Ⅰ is anode and the working (galvanic)Ⅱ is
cathode. The current flows from electrode Ⅰ to electrode Ⅱ.

During measurement, the potentiostat will automatically switch current range according to
the current.
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Data Acquisition
If Frequency (Hz) is chosen, the acquisition rate in points/second is specified.

Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.

14.2Electrochemical Stripping/Deposition

Experiments→ Misc.Techniques→ Electrochemical Stripping/Deposition
A constant polarization potential is applied on the working electrode, and monitor the

polarization current as a function of time. The polarization total time can be specified by the
user, and it can also be set as that when the polarization current achieves a certain value, test is
automatically terminated.

Deposition Parameters
Applied potential (V)—it is the potential applied to the measured system. For CS series

electrochemical workstation, if the polarization potential is “vs. OCP”, then negative value
means cathodic polarization, and positive value means anodic polarization. By clicking on the
drop-down box, users can choose the applying way of polarization potential.

Total time— you can specify the duration of potentiostatic polarization; time unit can be
“second”, “minute” or “hour”.
Experiment Termination

If you select “Use I” and set the quiet time and current sampling interval, the software will
automatically terminate potentiostatic polarization test once the polarization current is higher
than the specified maximum value (anodic current) or lower than the specified minimum value
(cathodic current).

If you choose “Based on Di/Dt”, the program will automatically terminate potentiostatic
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polarization test once the Di/Dt is higher than the set value.
If you choose “Disable”, neither of the two conditions to terminate the test works.

Data Acquisition
If Frequency(Hz) is chosen, the acquisition rate in points/second is specified.

Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.
14.3Electrochemical Potentiokinetic Reactivation (EPR)

Experiments→Misc.Techniques→Electrochemical Potentiokinetic Reactivation
This technique can be applied to evaluate susceptibility to intergranular corrosion. It can

be determined by Ia/Ir (activation peak current/reactivation peak current). It can also be
obtained by the ratio Qa /Qr. When the experiment is finished, the measured data can be
analyzed and obtain the value of Ir, Ia, Qr, and Qa through “EPR index calculation” of
voltammetric analyzing &fitting.

Parameters setting
Initial E/Final E/Scan Rate: please refer to the parameter setting in technique

Potentiodynamic.
Sleeping Time: the time staying at final potential.
Cycles: The number of cycles can be set. A complete cycle is finished scanning from the

initial E to final E.

14.4 Bulk Electrolysis with Coulometry (BE)

Experiments →Misc.Techniques →Bulk Electrolysis with Coulometry
In Bulk Electrolysis with Coulometry (BE), a constant potential is applied and the
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integrated charge is recorded as a function of time.

Parameters setting
Preelec E(V): the potential in pre-electrolysis process.
Preelec T: duration of the pre-electrolysis process.
Electrolysis E(V): the potential in electrolysis process.
Electrolysis T: duration of the process of electrolysis.
End current ratio (%): One condition to terminate the electrolysis process.
Electrolysis T and End current ratio jointly determine the termination of electrolysis.

Data Acquisition
If Frequency (Hz) is chosen, the acquisition rate in points/second is specified.

Axis Type
When the experiment is performed, the data will be displayed as specified by the Axis

Type. CorrView can be later used to display the data in other formats.

14.5 Solution resistance Rs measurement

Set the AC amplitude and test frequency, and click "Start". After the test, the software
will display the value of the solution resistance Rs. Repeat three times to get the average value
of the solution resistance.
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14.6 Cyclic Polarization Curve (CPP)

Initial E, final E and scan rate: you can refer to contents in potentiodynamic
Return potential: the reverse scan final potential
Reverse scan rate: the scan rate from final potential to initial potential
Constant potential conditions
When you check the first condition, it means, when the response current is higher than

your set value, the instrument will apply a constant potential. You can set this constant
potential and the duration/keep time. The logic is similar for second condition.

If you don’t choose any condition, it will not proceed the potentiostatic process.
Potentiostatic: if you set vs. Meas, the potential the instrument actually apply is the sum

of the instantaneous potential when potentiodynamic stage turns to potentiostatic and the
setting value here in potentiostatic. If vs. OCP, the potential the instrument actually apply is
the sum of OCP and the setting value. If vs. RE, the potential the instrument actually apply
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is the setting value.

14.7 Multi potentiostatic

It aims to achieving custom measurement that multi potentials, multi duration for each
potential can be set.

Set the value of the potential and applied duration/step time

Modify potential and step time
Remove the selected project

Remove all

move up and down to adjust the order
You can import several parameter settings at one time

15. Timing measurement
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It aims to setting the running mode of a certain experiment. This function allows the user
to perform automatic measurement at a set time interval after a specified time. It facilitates the
user to track the time change characteristics of a certain testing system.

After a file name is specified, the start will be activated.
You can specify the exact time the experiment will run from and the intervals for each

measurement and the total cycles of the measurement. It also displays the current cycles it has
run.

For the experiment involves polarization (such as potentiodynamic, cyclic voltammetry,
EIS), after each cycle, the instrument will automatically cut off the polarization and let the cell
be in the status of OCP till the next measurement/cycle.

When the times of the measurement reach the total cycles, the window will exit
automatically to end the project. The user can judge the measurement time according to the
serial number at each data file name.
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16. Graph Display

16.1 “.cor” Data file Graphing

Data file format:
EIS: .z60
Others: .cor
The data file can be open by notepad in txt format. And it can be copied and pasted to

Excel for drawing.

For all the techniques based on constant potential, constant current, galvanic current, the
window displays real-time data in the form of graphs, and can “stop”, “pause”, or “reverse”.

Double-click to import a data file
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dynamic graph display window

The file name is shown at the top of the window. The techniques such as potentiostatic,
potentiodynamic, parameters such as the scan rate, measuring time, working status, total data
amount, etc, and test completion percentage will be shown at the bottom.

CS Studio will automatically find the best beginning and end point in the coordinate and
refresh the graph in real time.

Coordinate

E vs. time- the abscissa is time in “second”; the Y- axis is potential of the electrode.
I vs. time- the abscissa is time in “second”; the Y- axis is current.
E vs. I- the abscissa is current; the Y- axis is the potential of the electrode.
I vs. E- the abscissa is the potential of the electrode; the Y- axis is current.
E vs. Log I- the abscissa is the logarithm of the absolute current; the Y- axis is the

potential of electrode.
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E+I vs. time- The abscissa is time, and the Y- axis is electrode’s potential and polarization
(galvanic) current.

Q vs. Time - the abscissa is time and the Y- axis is the integral quantity of electric charges.

Zoom In
If you want to zoom in a local position, you can left-press the mouse button on the target

area, and drag it to the lower- right side, and then release the button. The selected graph will
be immediately zoomed in and fill up the entire window. The graph will not be updated, but
CS studio is still scanning and acquiring data signals. If you want to go back to the previous
state, please just double click the mouse anywhere on the graph or click “zoom out”.

Buttons
Stop

Click to stop the ongoing test.
Pause/Start

Click to pause the test, re-click to resume the testing.
Reverse

Click button then the scan direction will be reversed. It is only used in potentiodynamic
and cyclic voltammetry test. A single click will let the scan direction reverse, and the scan rate
keeps unchanged. Click again, then the direction will be returned to the original.
Polar off

Click then you can change the state of the electrode polarization anytime.
Print

Click , then the real-time graph in the window will be output to the printer immediately.
Copy

Click then the real-time graph in the window can be copied and pasted.
Auto zoom

Click then the real-time graph will zoom in and fill up the entire graph window.
Data reader
It shows the real -time data, from left to right they are: data points, time(s), potential(V),

current(A). If you want to know the value of a certain point, you can click the icon and
move the mouse cursor on that specific point on the graph. The value will be displayed
immediately. For example, if you set coordinate to be “E-T”, then the text will be the time and
potential; and if you select “E-I”, then the text will be current density and potential.
Show Grid

Click , the coordinate grids will be shown, click it again not to show the grids.
Show Parameters

Click then the testing parameters can be shown, click it again not to display.
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Show Mark

Click button to display the mark. Click it again to cancel display.
Help

Click to get help info. of the test at present.

16.2 “.z60” Impedance Data

CS studio will display the real-time impedance data. The real part, the imaginary part, the
impedance modular, phase angle and frequency will be displayed. The measuring data will be
automatically saved.

Data reader

If you want to know the value of a certain data point on the graph, you can click and
move the cursor to the graph area, then the data will be displayed immediately. You can read
the real part, imaginary part, frequency, impedance modular and phase angle of a data point
in“Nyquist” or “Bode” plot, as shown in below.

EIS vs. Frequency testing window

Zoom in
If you want to zoom in a local position, you can left-press the mouse button on the target

area, and drag it to the lower- right side, and then release the button. The selected graph will
be immediately zoomed in and fill up the entire window. The graph will not be updated, but
CS Studio is still scanning and acquiring data signals. If you want to go back to the previous
state , please just double click the mouse anywhere on the graph or click “zoom out”.

Note: Due to the large amount of data during the test, you’d better use the zoom in
function after the measurement.

Stop
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Click button to stop the testing and change from polarization status to natural status.
Waveform
The waveform window shows the acquired potential and current waveform during EIS

test, and guide the user to choose the suitable “Min. High Freq. range” and “Bandwidth” in the
analyzer setting. If the noise is big, you should probably increase capacitance of the bandwidth
filter, and prevent measuring system oscillation.

For EIS test of high-impedance system, if you don’t open the bandwidth response
capacitor in analyzer setting, oscillation may happen, as shown in below. In this picture, you
can’t see sine signals, and the amplitude is not 10mV, meaning there is oscillation in the
testing system.

(close bandwidth capacitor) acquired potential / current waveform(oscillation appears)

Choose the bandwidth capacitance to be “22pF” in analyzer setting, then you can see the
normal sine wave signals, suggesting that the instrument can response to the applied sine wave
signals, and works properly. As shown in below picture, the amplitude of the potential signals
is 10mV, in accordance with the amplitude of the applied signals. Meanwhile, the current
signal is around 100μA, matching the selected current range 200μA. If the current amplitude is
too big or too small, there will be relatively big error in the measured impedance spectroscopy.
You should re-adjust the min. high freq. range in analyzer setting.
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(selecting 22pF capacitor) acquired potential/current waveform (normal sine wave signals)

If just current signals noise is big, the cause may be high input impedance of the reference
electrode loop (eg. high-impedance coating). You should increase the capacitance of the
bandwidth filter to improve the stability.
17. Tools

17.1Data Export

This command is to export the data file of the active window, and save as data file
suffixed with “.cor”. The data format is “.csp” if you choose “save project as”.

17.2Data fitting

There are: Tafel fitting, linear fit, integration, Noise, cell information, modify data, Rp fit,
Least square method etc.

Data Fitting

Modify Data
This is used to change the original data for data / graph offset and flipping. After

modification, all data is changed. During switch, there will be a prompt to ask if you want to
save the data.

If you want to do subtraction, you only need to enter a negative value in Addition. If you
want to do division, you just need to change the corresponding relationship.

Cell info.
See Cell Setting 3.2.
Electrode area is the area of the working electrode. If it is 1, the current density will be the

same as the measured current in value.
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CS studio employs material density or the chemical equivalent for corrosion rate
calculation. Chemical equivalent= atomic weight/the number of electrons transferred in the
reaction. For example, for reaction Fe-2e→Fe2+, the number of transferred electrons is 2, then
the chemical equivalent is 55.8/2=27.9.

If such values are not entered, then the software only calculate the polarization resistance
Rp or the Tafel slope, and cannot calculate corrosion rate.

“Polarity” determines how the positive/negative potential/current is interpreted. When
choose the normal “O2+”, a more positive potential will produce a bigger oxidation driving
force, meanwhile the generated current is positive. If you choose “O2-”, a more negative
potential will produce a bigger oxidation driving force, the oxidation current value is negative.

Rp fitting
Polarization resistance is the slope of the E-I curve near the open circuit potential.
If the data range is set to be “auto”, CS Studio will automatically find the open circuit

potential (current is around 0), and choose data range of 20mV at each side of the OCP. If you
don’t think this is an appropriate range, you can re-position the mouse on the curve to select a
desired data range, or directly enter a max. and min. potential.

Fitting results:
Rp (Ohms/cm2): slope of the curve
E0(V): The potential where polarization current changes direction. They usually keep in

accordance with the OCP of the system.
I0(A/cm2): current density is computed based on the Stern-Geary equation (Stern-Geary, J.

Electrochem.Soc. 104,561957)

����� =
�� × ��

�� + ��
×

1
��

Because the Tafel slope (Ep&bc) cannot be obtained directly in linear polarization area,
CS studio program assume it to be 0.12V/dec, thus for Stern Geary coefficient:

� =
�� × ��

�� + ��
=

�� × ��

2.303(�� + ��)

Normally, assign the B to be 18mV (it can also be set in cell info.), then,

�����(mA/cm2) =
18mV

RP

Corrosion rate is calculated according:
MPY =Icorr(A/cm2)×chemical equivalent (g/mol)×393.7(mil/cm)÷density(g/cm3)×365

×24×3600(s/Y)÷96500(C/mol);
mm/a = MPY÷39.37(mil/mm).
For carbon steel,1mm/a = 11.73×Icorr (mA/cm2), 1MPY = 462.2×Icor r(mA/cm2)

Therefore, only after the electrode parameters are set can the corrosion rate of metal be
calculated.

Tafel fitting
It provides four methods. The anodic/cathodic fitting is based on linear fitting principle:
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� = �0 10
�−�0

�� − 10
− �−�0
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If fit Ba, then i = i0×[10(E-Eo)/Ba] can be simplified as: lgi = E/Ba + lg i0– E0/Ba. Then it
becomes a standard linear equation. i0and Ba can be calculated.

Using the same method, you can calculate Bc. If fit the Ba and Bc respectively, then we can
calculate E0and i0 more accurately.

Auto fitting
By auto fitting, the software will automatically find the data in range of 200mVaround

open circuit potential, and then do the anodic and cathodic fitting respectively, obtaining two
equations and the intersection of the two lines. The more accurate i0and E0will be obtained,
then we can calculate the corrosion rate.

Least square method
This method is usually used to do fitting of multi parameters, such as 4-, or 5- parameters

fitting. It employs Levenberg-Marquardt fitting. If iL is not used, then the equation is:

� = �0 10
�−�0

�� − 10
− �−�0

��

If using the iL, then the fitting equation is as follows:

� = ����� �
�−�0

�� −
�−�−�0

��

1 − �0
��

1 − �−�−�0
��

During fitting, you must assign an initial value to the program.
After obtaining Ba, Bc, Stern-Geary coefficient is calculated according to the following

formula:

� =
�� × ��

�� + ��
=

�� × ��

2.303(�� + ��)

If the data range is set “Auto”, CS studio software will automatically find the OCP, then
choosing 250mV range for anodic and cathodic part. If you don’t think it’s a suitable range,
you can re-choose a range by locating the cursor in the curve. Then only data points between
the two cursors are involved in the computing. You can also enter max. and min. value to
directly specify the range.

Linear fit
There are six types of fitting we provide, but the latter five methods are based on the first

type, i.e., according to linear equation: y = a + bx.
Linear fit principle
The linear fitting is based on the least square method.

θ a, b =
�=1

�

(�� − � − ���)2�

By computing the acquired data points, we can obtain the value of a,b to make the
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minimum θ(a,b).
��(�, �)

��
=− 2

�=1

�

�� − � − ��� = 0�
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=− 2
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Expand the equation:
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Other linear fittings
Take the function:i=i0×10E/B for an example:

Firstly you should judge the sign of the i; it can be either all positive or all negative.
Convert the equation to be lgi = lgi0 + E/B. Assume lgi = y, lgi0 = a, 1/B = b, then it’s
simplified to be a standard linear equation. Find the value of lgi0and 1/B, then calculate the
i0andB indirectly. The value of i0 is determined by the sign of i.

Integration
There are two kinds of integration, with background and without background. The
calculation way is basically the same, using trapezoidal integration.
Q (Quantity of electric charges)
Trapezoidal integration means to calculate the area of the trapezoid constituted by two

adjacent points, that is, to do trapezoidal integration for every data point on the I-T graph. The
current value is the bottoms, and the time difference (Δt) is the height (see the picture as
below). The sum of each trapezoidal area is the quantity of electric charges.

Q integration area diagram

Q (with background)
If the Q is with background, then we should find the area between two points and the

connection line of them. As shown in below picture, the area of the gird is to be obtained. It
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equals to the difference between the area constituted by points collection and the area of the
lines.

Q integration(background) area

Noise
We can use the method of root-mean-square (RMS) to calculate the noise between cursors,

and show the results.
E_RMS represents the RMS value of the potential noise after removing the background

drift.
I_RMS represents the RMS value of the current noise after removing the background

drift.
The formula is as follows:

RMS = i=1
n xi

2�
n

Where, n is the number of data involved in the calculation, xi is the #i data value.
Note: The results of the calculation strongly depend on the quality of data, sampling rate,

influence of filter and ambient noise etc. The validity of results depends entirely on the user’s
judgment.

17.3 Voltammetry Analysis

In the menu of voltammetry analysis, there are: CV, DPV, NPV and EPR index
calculation.

Cyclic Voltammetry
CV graph Display
In the data file, there is mark of cycle, so it can display each cycle. If the number of cycles

is more than 2, then there is a radio button “Show”. Check it, you can adjust the graph display,
from which cycle to which cycle, as you wish.
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Auto
The program provides a method to find the peak: divide the data points cycle by cycle,

then find the peak and valley of each cycle, and find a baseline which parallels to the X axis
most, obtaining the peak height and half-peak area. You can also find the peak and baseline
manually.

CV auto analysis

Anodic peak between cursors

By swapping cursor , you can locate the beginning and end position for the anodic
peak. The software will make the scan direction as baseline, and find the highest point as the
peak. The peak height and half-peak area can be calculated.

Anodic peak interface between cursors

Cathodic peak between cursors
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Through swapping cursor , you can locate the beginning and end position for the
cathodic peak. Then the software will find the peak height and the half-peak area according to
the baseline and the bottom point.

Cathodic peak interface between cursors

In CV analysis, in order to show the height line, the coordinate axis must be I vs. E.
Capacitance calculation
For CV graph, you can calculate the capacitance according to the following formula:

C = �1

�2 ����
2�∆�

WhereE1, E2 is the minimum, maximum potential value in CV scan;
ΔE=E2-E1, v is the scan rate
The result is shown like this:

Segment 2:
Area = 1.6438E-05 W
ΔE = E2-E1 = 0.79803 V

Scan rate=0.05 V/s
C = 0.00020598F

Differential Pulse Voltammetry (DPV)
It provides two methods: Auto and Peak between cursors.
Two methods are supplied for DPV: auto and peak value between the cursors.
Auto
The software will automatically find the maximum current value as the peak height, and

find the place where the slope is near to zero to be the baseline, then calculate the peak
height and half-peak area.
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DPV curve in K3Fe(CN)6 system

Peak between cursors
Because there will be error or what you obtain is not what you want by auto method, we

supply manual method. By swapping the cursors to determine the beginning and ending points,
the software will then find the peak height and half-peak area based on the baseline and
highest point.

In voltammetric analysis, in order to show the height line, the coordinate must be I-E.

Normal Pulse Voltammetry(NPV)
It supplies two methods: Auto and Peak between the cursors.
Auto
Firstly you should find the median current, and then make the line that most parallels to

X-axis as the baseline, then calculate the height.

NPV curve in K3Fe (CN)6 system

Peak between the cursors(manual)
Find the median current of the data points of a whole segment, and make the baseline of
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the point where the cursor is on, then calculate the height between two baselines.

17.4 M-Scurve analysis

“Tools ”→M-S curve analysis

The generated EIS data file (.z60) is compatible to ZView software, but ZView cannot do
Mott-Schottky analysis. After data acquisition, you should click “Tools”→M-S curve analysis

to open the M-Scurve analysis. Click to import a data file, click to open M-S curve
fitting interface.

M-S curve analysis interface

Click to get the following M-S curve fitting interface:
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17.5 Filter

Two different digital filtering methods are available to eliminate burrs or noise in the data
file. You should find the suitable method according to the type of noise.

The first type is “Remove burrs”. It is especially suitable to data file that includes
abnormal burrs. For every data point in the file, you can firstly choose 5 points(current point,
the 2 points before it, and 2 points after it), delete the maximum and minimum one, then make
the average of the left three points as the new value. Using this method to handle every data
point, you can effectively remove the burrs resulted from range change of the potentiostat and
the interference noise caused by repeated on-off of the temperature controller, or the discrete
noise signals.

The second type is “5 to 25 point smoothing”. This method employs Savitzky Golay(SG)
smoothing algorithm to remove the random noise. (“Smoothing and Differentiation of Data by
Simplified Least Squares Procedures”, Analytical Chemistry, Vol. 36, No. 8, July 1964, page
1627).

If you need to use both of the two methods, you must first use “Remove burrs”.
These smoothing methods do not change the saved data file. But if you use filter and then

switch to another data file (via the active data selection box), you will be prompted to save the
modified data as a new file.

If you need to return to the original data, you can select the same file from the active data
selection box. When the software prompts you to save the modified data file, click “No”.
Note: Please use the filter with cautiousness. The better way is to resolve the noise problem
instead of covering it. Improper usage of the filter may lead to missing of some important
information (such as the potential and current peak formed by passivation film rupture on the
surface of the electrode). Before using the digital filter, it is suggested that you check the
actual noise level of the potentiostat output signals by an oscilloscope so as to determine
whether to use the filter.

17.6 Delete Data

It supplies three methods: delete data point, delete data between cursors, and delete data
outside cursors. After the data is deleted, the source file will be unchanged. The data after
modification can also be saved via “Tools” → “Data Export”.
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Delete Data Point
Considering that there may be an abnormal data point in a data file, you can use this

command to delete it. After the data point is deleted, the source file will be unchanged. The
data after modification can be saved via “Tools”→ “Data Export”.

Delete data between cursors
You can use this command to delete all data points between two cursors. After the data

segment is deleted, the source file will be unchanged. The data after modification can also be
saved via “Tools” → “Data Export”.

Delete Data outside cursors
In an experiment (eg. Voltammetry stripping test), it is possible that there is only a

segment of data that is valid, then using this command, all the invalid data points (outside the
two cursors) can be selected and deleted. After deletion, the source file will be unchanged. The
data after modification can also be saved via “Tools” → “Data Export”.

17.7 EIS Analysis

ZView is a powerful EIS analysis and graphing software. It can do various
electrochemical parameters computing, and do smoothing and digital filtering to the original
potential and current data. It can also compensate solution resistance by software. ZView
interface is clear, and the data, graphs can be easily printed and saved, and output to Word in
vector mode.

ZView impedance analysis interface

Toolbar is the shortcut keys of the menu. If you locate the mouse cursor on the icon, there
will be explanation of the icon.
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Open data files

Click “File” → “Data Files” (or directly )to import the EIS data file, as shown in
below:

ZView data import window

Activate data
Choose the data file which is to be analyzed (marked 1).

ZView: choose the active data file

Delete data range
Select the unwanted data range (the part cannot be fitted by ZView) by the mouse cursor,

and then delete them through Tools →Delete Data Range.
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ZView : delete data range

Instant fit
Instant fit is to obtain the initial value, a preparation for the formal fitting afterwards.

(1) Choose the element one by one for instant fitting individually.
(2) Click for instant fitting.
(3) Choose the suitable equivalent element (eg. the one marked 2), and obtain the initial

value of the equivalent circuit.

Complex equivalent circuit fitting
Build the suitable equivalent circuit based on the instant fit (see the below picture as an

example). It depends on the actual testing system.
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Choose the suitable equivalent circuit from ZView for formal fitting

Drag the data in place “1” to place “2”, as shown below:

Drag the data from the instant fit window to the initial value entering box

Change “fixed” to “free”, shown in the following picture:
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Data fitting based on equivalent circuit

And change the mode from “Simulation”to “Fitting”

Parameters setting dialog box

The place marked with “1” are the fitting results. If you want to re-graph for the results,
choose “fit result” in place “2”, and click to show the data. After copying them to the
clipboard, they can be copied to Excel or Origin software.
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Fitting results and fitting curve
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18. Windows
This option is used to manage all current project subforms.
Cascade
All project subforms are displayed in the form of Cascade
Tile
All project subforms are displayed in the form of Tile
Arrange
All project subforms are rearranged.
Close all
Close all project subforms.

19. Help
Index and search: manual
Language: English and Chinese optional
Contact us: click to go to our company website, showing the contact info.
Check for update: click to update the software to the latest version
About: the version of the software, hardware, the serial no. etc of the instrument.

20. FAQs
1. How to use dummy cell to check the instrument?

Connect the green clamp to WE, the yellow clamp to RE, and the red one to CE.

Open the software, Click setup→Reset Workstation. During experiment, the potential and
current value should always obey the Ohm law: I= E / R
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Click Experiments→Potentiostatic, set the applied voltage to be 1.1V, start the test. If the
displayed potential value is 1.1V, and the current is 1mA, it means the instrument potential
output is normal.
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The same way, click Experiments→Galvanostatic, set the applied current to be 1mA, start the
test. If the displayed current value is 1mA, and the potential value is 1.1V, it means the
instrument current output is normal.

Combining the results, we can say the electrode cable is no problem.
2. How can I use the data to graph in Excel

The data file can be open directly in “notepad” ( txt format). And data can be copied and
pasted into Excel. You can find the demonstration in Training video file “Open data and paste
into Excel”.
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3. How can I save the data during experiment and how to find data file after experiment?
After you enter a name for your test here in “file name”, and click “browse” to choose a

place, then the data will be saved in that place automatically during test. After the test, you can
find the data file and open it in notepad (.txt format) You can copy the data into Excel.

If you didn't click “Browse” to choose a path for saving of data, then the data will be
saved in the default place “Setup→Settings”.

4. How can I connect my actual testing system by the electrode cable?



Manual of Corrtest Potentiostat / Galvanostat

- 114 -

Three electrode system Cable connection

Greed clamp (WE) connects to working electrode (WE)
Red clamp (CE) connects to counter electrode (CE)
Yellow clamp (RE) connects to reference electrode (RE)
Black (GND) connects to galvanic electrode WEⅡ in
electrochemical noise experiment. If use a Faraday cage, black
GND and Shield connect the cage together.
Two electrodes system Cable connection

The green lead connects to WE or anode;

red lead & yellow lead together connect to another electrode or cathode.

5. How to reduce the noise in electrochemical experiment?
(1). Make sure the solution in salt bridge is conductive, and that the tip of the RE is drown in
the agar and connected well with the working solution. To make sure the microporous ceramic
is well socked, so as to reduce the RE impedance.
(2). Open the filter to improve system stability.
(3). Give a serial capacitor (100nF) between the RE and CE if the noise resulted from the
solution resistance is unavoidable.
(4). For corrosion test, add a 1μF capacitor between WE and machine shell of the
potentiostat.
(5). For impedance test, make a parallel connection of a Pt wire and RE. Dip one end of the Pt
wire into solution and connect the other end to RE output port by a 100nF capacitor.
(6). All of the equipment in the experiment incl. the PC must be connected to the ground using
individual ground wire. If there is no suitable ground wire, you can use a thick copper wire to
connect the PC with a nearby metal conductive water tap.
(7). Shut down all the possible environmental interference source, such as high-power power
supply, computer monitor, stirrer, and fluorescence light etc.
(8). Use the Faraday cage, and connect it to the ground.
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21. Service & Contact us

After-sales Service:
1. Warranty period: 5 years. During this period, all service including repair is FREE.
2. Provide installation guidance and manual, software installation video.
3. Lifetime free software upgrading of the same model and technical service

Technical Support Center

Email: service@corrtest.com.cn
Tel.: (+86) 18086482080, (+86) 18086482081

Sales Center

Email: sales@corrtest.com.cn
sales2@corrtest.com.cn

Address: Room 505, Jinfeng Building A, International Enterprise Center, Optics valley
Ave.,East Lake High-tech Development Zone, Wuhan, China, 430074

Website:
www.corrtestinstruments.com/en

22. Appendix-electrochemical accessories
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Appendix

Electrochemical Accessories

Model Product Picture Specification

CS900 CS900 Saturated Calomel
Electrode

Saturated KCl refilling
solution

CS901 Ag/AgCl reference electrode Ø4mm/Ø6mm
3.5M KCl refilling solution

CS902 Hg/HgO reference electrode Suitable for alkaline/base
solution
1M KOH refilling solution

CS903 Mercury/Mercurous sulfate
electrode

suitable in acid solution
Saturated K2SO4 refilling
solution

CS905 Non-aqueous Ag/Ag+

reference electrode
Ø4mm/Ø6mm
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CS910 Platinum conductivity
electrode

CS911
Platinum plate electrode
**Size can be customized

99.95%,10x10x0.1mm

99.95%,10x10x0.2mm

99.95%,20x20x0.1mm

99.95%,20x20x0.2mm

99.95%,20x20x0.3mm

CS912 Platinumwire counter
electrode

99.95%, Ø
0.5x37mm(wire)

CS913

Platinummesh electrode 10*10mm

20*20mm

CS915

Graphite rod Φ4 / 6mm, length 150mm

CS916

Graphite electrode
Ø2~ Ø5mm
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CS920
Glassy carbon working
Electrode

Ø3mm

Ø2mm

Ø4mm/Ø5mm

Ø6mm

CS920L
L-shape glassy carbon
working electrode

Ø3mm

Ø2mm

Ø4mm/Ø5mm

CS921
Metal Electrode

Carbon steel, stainless
steel, copper

Working area: 0.5cm2

CS922

Platinumworking electrode 99.95%, Ø2mm

99.95%, Ø3mm

CS923 Gold working electrode

99.95%, Ø2mm

99.95%, Ø3mm

CS924

Silver working electrode Ø2mm / Ø3mm

TitaniumWE Ø2mm / Ø3mm

CopperWE Ø2mm / Ø3mm

AluminumWE Ø2mm / Ø3mm

Nickel WE Ø2mm / Ø3mm

Zinc WE Ø2mm / Ø3mm
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CadmiumWE Ø2mm

IronWE Ø2mm

PalladiumWE Ø2mm/ Ø3mm

CS925
Pt micro electrode

10μm/25μm

CS926
Gold micro electrode

12.5μm/25μm

CS927

PINE RDE
Glassy carbon disk electrode
3mm/4mm/5mm

Electrode is
internal-screw type.

Compatible to PINE's
RDE equipment with
external-screw rod

Pt/Au disk electrode
also available

Electrode is
external-screw type.
Compatible to PINE's RDE
equipment with
internal-screw rod.

Pt/Au disk electrode
also available

PINE RRDE

RRDE- Glassy carbon
disk, Pt ring electrode

Compatible to PINE's
RRDE equipment
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ALS RDE

Glassy carbon disk
electrode- Disk diameter
3mm, Insulator diameter
12mm, length 25mm

ALS RRDE

Glassy carbon disk working
electrode OD of ring
electrode7mm, Inner
diameter 5mm; disk
diameter 4mm, Insulator
diameter 12mm, length
25mm

ALS Pt Wire Platinum counter electrode
φ 0.5*230mm

CS930

Glass electrolytic Cell, 4 ports

**Include salt bridge and gas
inlet/outlet pipe

150ml

250ml

500ml

1000ml

CS9305 Corrosion Cell, 5 ports

500mL

Includes all the electrodes

The cell kit includes:

A specimen holder (1cm2
working area) * 1

Graphite rods *2

Pt plate electrode*2
(10*10*0.1mm)

Saturated calomel electrode *1

Salt bridge*1

F-shape gas inlet and outlet*1
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CS931

Jacketed glass cell
(None-sealed)

**Holes on the lid can be
tailored. No include the
electrodes shown in the pic.

50ml

100ml

150ml

CS931S Jacketed glass cell
(Sealed)

**Holes on the lid can be
tailored. No include the
electrodes shown in the pic.

50ml

100ml

150ml

CS932 H- cells
(None-sealed)

None-sealed
Volume:50~250mL

(each cell,
PTFE caps. The two cells
are separated by ion
membrane which is
prepared by user.

CS932S H- cells (sealed)

**Holes on the lid can be
tailored. No include the
electrodes shown in the pic.

Sealed
50~250 mL (each cell)
PTFE caps
The two cells are separated
by ion membrane which is
prepared by user.

CS933

Photoelectrochemical
cell(quartz)

**Holes on the lid can be
tailored.

30*30*30mm

35*15*45mm

40*40*40mm

50*50*50mm
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CS9331
None-
sealed

Photoelectrochemical cell

**Holes on the lid can be
tailored. No include the
electrodes shown in the pic.

For working electrode, you’re
recommended to use
L-shape electrodes, or the
CS945 electrode clamp.
50ml 100ml 150ml

Sealed

*Glass cell, Teflon cap,

Quartz light window (dia.

24mm).

CS9331S
(Sealed)

CS9330 Spectroelectrochemical cell
(cuvette cell kit)

This kit includes:
Quartz cuvette
12.5*12.5*42mm,
Teflon cap,
Pt mesh(WE),
Pt wire counter
electrode(CE), Ag/AgCl
reference electrode(RE),
Purge tube
optical path: 8*6.5*1mm

CS934
Coating evaluation cell
(Paint test cell)

10mL
Working area is 1cm2

CS935
Electrolytic cell
(None-sealed)

**Holes on the lid can be
tailored. No include the
electrodes shown in the pic.

50mL/100mL

150mL/200mL/250mL
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CS935S

Seal electrolytic cell

** Holes on the lid can be
tailored. No include the
electrodes shown in the pic.

50mL

100mL

150mL

250mL

CS936

Flat corrosion cell
-None-jacketed

working area is 1cm2

including:
Ag/AgCl reference

electrode
Counter electrode: Pt

mesh*1 (20*20mm)

Flat corrosion cell
-Jacketed

Jacketed, water circulation
for temperature control
working area is 1cm2

including:
Ag/AgCl reference
electrode *1
counter electrode: Pt mesh
*1 (20*20mm)

CS937 Glass cell + Teflon cap

Glass cell: 10ml
Diameter of the three
holes:
φ6.35mm, φ6.35mm,
φ6mm

CS940 Cell stand 1

Match CS930 glass cell
Base material: carbon steel.
Not included the cell and
electrodes which are for
demonstration
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CS941 Simple Cell Stand

Base material: PTFE
provide 2 pieces cells
(30ml)

CS942 Electrode polishing kit

Alpha alumina powder
0.05µm,0.3µm,1µm, 10g each

Nylon polishing
pad (Ø200mm) *1

Microcloth polishing
pad (Ø200mm)*1

Carbimet disks

(1200-4000 grit, Ø200mm)*1

-Glass plate*2

CS942 Faraday cage
25*25*30cm

CS945
Specimen clamp

**The price is for one
electrode

Suitable for plate
specimen with thickness:
< 1mm.

CS946 Specimen holder

Effective Working area is 1cm2.

Round specimen: diameter:
11.5~15mm, Thickness 0.1 ~
5mm.

Only One face of the sample
contacts with the solution.

PVDF rod diameter 10mm,
length 100mm
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